| introduction | Hw installation | Sw installation | Sw interface | acceptance | ECU diagnosis | programming | active diagnosis | engine test | electrical diagram | guide to diagnosis |
| eltracscope | Bluetooth Device | sw automatic updating | certifications |

unit O

introduction
ATTENTION! GENERAL RULES FOR USE
This software may cause chassis movements and/or engine start-up. The following instructions should always be strictly followed:
Be extremely careful. . .

- check all instruments and ensure the vehicle is parked safely

The user is responsible for the correct use of the EASY. software so as not (e.g: handbrake on, wheel chocked and with gearbox in neutral, etc...)
to any cause injury to people or damage to items. - ensure that the ECl module is connected to the diagnostic socket of the

vehicle on which work is to be carried out
- in case of emergency, disconnect the EClI module from the vehicle or

. . , disconnect the USB cable
Carefully read the user manual before using the diagnostic tool and follow _ensure that while using the software, there is nobody near the vehicle you

the instructions displayed on the screen. are working on

The user is also responsible for complying with all the rules relating to
vehicle security and activities in the workshop.

- if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of
the workshop

- we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).




introduction

The new E.A.SY. Diagnostic System for IVECO commercial vehicles has an entirely new instruction handbook.
In addition to new graphics, the handbook structure follows new principles. Topics are presented in “modules” which form independent units.

The manual consists of the following units:

m Huw installation

m Sw installation

m Sw interface

B Qcceptance

m Ecu diagnosis

B Programming

B Qctive diagnosis

B €ngine test

B Electrical diagram

m Guide to the diagnosis
B @iltracscope

m Biuetooth Device

B Sw automatic updating

B Certifications

Each unit can be downloaded from the following Internet Page: www.eltrac.it.

There are three EAASY. Diagnostic System market-specific configurations. Each configuration is presented separately, where required.

INTRODUCTION


http://www.eltrac.it

The handbook was restyled to meet the revolutionised new Diagnostic System interface which results by implementing more user-friendly navigation principles.

The new EASY. software was specifically developed to assist and facilitate electronic system troubleshooting and programming in the workshop. The interface
ensures easily understood troubleshooting procedures which adapt to all diverse needs.

E.ASY.is innovative and surprisingly simple to use. Troubleshooting, programming and testing procedures become immediate. Accessing the various environments
is more intuitive.

By observing the EAASY. interface three main operative areas are available, associated to specific functionalities:

- Title Area
- Operative Area
- Keys Area
TITLE AREA
[ l 1 It indicates the dynamic update of the area name under test and shows previous choices by which you
arrived.
Useful for mentally retracing the selections made at any time.
OPERATIVE AREA
Contains systems or functions lists available for the
intervention area.
The pull-down lists display other selectionable lists.
INTRODUCTION



KEYS AREA

Contains keys for accessing the different
environments and the functions to which
they are associated.

Details about the HW installation are described in the » unit .
| Details about the SW installation are described in the » unit 2.

Browse the units presented at the beginning to get to know your way round in the new EASY. application.

* M Hw installation * M Sw interface

» M Sw installation * MW Acceptance

* M www.eltrac.it * W ECU diagnosis
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Hw installation

ATTENTION! GENERAL RULES FOR USE

This software may cause chassis movements and/or engine start-up. The following instructions should always be strictly followed:

Be extremely careful. . L
’ - check all instruments and ensure the vehicle is parked safely

The user is responsible for the correct use of the EASY. software so as not (e.g: handbrake on, wheel chocked and with gearbox in neutral, etc...)

to any cause injury to people or damage to items. - ensure that the ECl module is connected to the diagnostic socket of the
vehicle on which work is to be carried out

- in case of emergency, disconnect the EClI module from the vehicle or

. . , disconnect the USB cable
Carefully read the user manual before using the diagnostic tool and follow _ ensure that while sing the software, there is nobody near the vehicle you

the instructions displayed on the screen. are working on

The user is also responsible for complying with all the rules relating to
vehicle security and activities in the workshop.

- if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of
the workshop

- we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).
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| EASY. configuration | EASY. LIGHT configuration | Modus Station /T 2000 Tester user

The diagnosis system consists of:

- a PC (Panasonic/ your PC + Microsoft Windows 2000 or Windows XP Professional /the Modus PC)
- an instrument used as interface between vehicle and PC (ECI tester or Modus Station/ IT 2000 tester)
- a SW program (EASY.) to process data

By combinating the above indicated components 3 different configuration are possible. Select your user configuration type and then follow the relevant information.

USERS TYPES: IDENTIFY YOUR CONFIGURATION

1. EASY. configuration. PC Panasonic user + ECl module + EASY. sw

2. EASY. LIGHT configuration. user with own PC + ECI module + EASY. sw

3. Modus Station/IT 2000 Tester user + sw E.ASY.

UNIT ONE
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| receiving the kit | recognize the supplied accessories | the Panasonic PC | led indicators and ports | the external CD-R DVD | the ECI module | use the kit |

The diagnosis system consists of:

- Panasonic portable PC (Toughbook CF 18, it is the platform on which the SV for the activation has been installed)
- EClinterface module

- EASY.SW CD

- CD with documentation

- quick guide

- CD-R/DVD unit

- cables and accessories (ref. Recognize the supplied accessories)

- registration form

EA.SY. configuration
complete kit

* M Recognize the supplied accessories

e M Sw installation

CHECK THE KIT CONTENTS

Receiving the kit

I underneath the ECl module you can find the USB cable for connecting the module to the portable PC
2 vyou can find all accessories behind the case divider

3 underneath the CD-R/RW unit you can find the USB cable to connect the unit to the portable PC

UNIT ONE 2
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| receiving the kit | recognize the supplied accessories | the Panasonic PC | led indicators and ports | the external CD-R DVD | the ECI module | use the kit |

Recognize the supplied accessories

OPERATIVE AREA

USB CABLE 4,5M A-ECI TYPE WITH EMIFILTER CABLE FOR VEHICLE CONNECTION

ECl side
The wire is 4.5 metres long
for arranging the laptop
computer comfortably
when it is connected to the
vehicle's diagnostic socket.

It allows the connection between the vehicle

diagnosis socket and the ECl module.
PC side

ACCESSORIES AREA>POWER SUPPLY AREA

PC POWER SUPPLIER FOR THE MAINS PC POWER SUPPLIER FOR CIGARETTE LIGHTER OUTLET

It allows to recharge the
battery and to use the PC

connected to the mains.
It allows to recharge the battery and

to use the PC connected to the
cigarette lighter outlet (12V or 24V).

UNIT ONE 3
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| receiving the kit | recognize the supplied accessories | the Panasonic PC | led indicators and ports | the external CD-R DVD | the ECI module | use the kit |

ACCESSORIES AREA>CONNECTION AREA

USB CABLE A-ECI TYPE WITH EMIFILTER USB CABLE

It enables the connection
between the ECl module
and the portable PC.

Underneath the CD-R/RW unit
you can find the USB cable to connect
the unit to the portable PC.

ACCESSORIES AREA>SELF-DIAGNOSIS AREA

SELF-DIAGNOSIS CONNECTOR

Applied to the ECI throughout the self-diagnosis
procedure, it enables to detect any failures.

UNIT ONE 4
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| receiving the kit | recognize the supplied accessories | the Panasonic PC | led indicators and ports | the external CD-R DVD | the ECI module | use the kit |

The Panasonic PC

It is a Panasonic personal computer with Windows XP Professional as operative system. lts dimension and weight are very small, with particular resistance features. It
is designed to work outside even under a wide range of weather conditions including heavy range and summer sun and to ensure top performances in terms of resist-
ance to impacts and foreign material (dust).

MECHANICAL PROPERTIES

Full magnesium alloy casing

Spray and dust resistant

Ports with protection caps

Hard disk with standard MIL STD 810F anti-shock system

TECHNICAL DETAILS

back lighted LCD MONITOR, 1024x768, touch-screen

MODEL Toughbook CF 18 MONITOR
technology
PROCESSOR  Mobile Centrino enhanced Intel SpeedStep Technology MODEM internal modem 56 kbps, RJI | connector
RAM 512 MB; DDR 266 MHz LAN 100 BASE-TX, connector RJ45 and 802.1 Ib (wireless)
VRAM 48 MB OPERATING SYSTEM  Windows XP Professional
HDD 40 GB POWER SUPPLY AC 100-240V, 50Hz/60Hz
Li-lon 7,4V; 4,4 Ah // autonomy: 3,5-5,5 hrs. // charge
BATTERIES

time: 3-5 hrs.

UNIT ONE 5
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| receiving the kit | recognize the supplied accessories | the Panasonic PC | led indicators and ports | the external CD-R DVD | the ECI module | use the kit |

The LCD monitor has been designed to be used under adverse light conditions, such as the direct sun light typical of the work-shop environment. It is supplied
with touch screen technology (it is also possible to use the supplied pen, housed in the bottom right-hand monitor compartment) and with an swivel device,
which allows you to double-up your machine to be a notebook, as well as a tablet.

On the front part of the PC you can find the buttons for power-on and for the brightness control and the battery status led indicators.
Some details are described below.

led indicators and ports>left side — front buttons

NETWORK CONNECTION

MAIL INDICATOR

SIGNAL RECEPTION

PC POWER-ON POWER SWITCH

i when the computer is turned off, slide the power

button on the right side: the computer turns on @
when the computer is turned on, slide again the
button: the Stand-by mode activates

UNIT ONE 6
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| receiving the kit | recognize the supplied accessories | the Panasonic PC | led indicators and ports | the external CD-R DVD | the ECI module | use the kit |

right side — front buttons

LCD BRIGHTNESS CONTROL

buttons for LCD brightness control

UNIT ONE

INPUT PANEL

by pressing the button a keyboard
is displayed on the LCD screen;
the keyboard can be used by
touching the letters/buttons on the
screen (touch-screen mode) or by
using by using the included stylus

ENTER

it is the same function of the
ENTER key on the keyboard

ROTATION

by pressing the button the screen

display rotates counter-clockwise

by 90° when you want to use the
PC in the Tablet mode

SECURITY

Same operation as when CTRL +
ALT + CANC are pressed; it
enable to lock the computer
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| receiving the kit | recognize the supplied accessories | the Panasonic PC | led indicators and ports | the external CD-R DVD | the ECI module | use the kit |

left side - front led indicators

CAPS LOCK
Green indicator light.
It lights when the CAPS LOCK is pressed. Pressing Caps Lock will make every letter you type a capital.

NUM LOCK
Green indicator light.
It lights when the NUMLK key is pressed. This causes a portion of the keyboard to function as a numeric keypad.

el

SCROLL LOCK
Green indicator light.
It lights when FN + SCRLK are pressed. It functions differently depending on the application.

o

HARD DISK DRIVE STATUS
Green indicator light.
This indicator lights when the hard disk drive is accessed.

o

BATTERY PACK STATUS

It indicates the battery status:

NOT LIT- Battery pack is not connected or charging not being performed. ORANGE INDICATOR LIGHT- charging in progress. GREEN INDICATOR LIGHT - fully-charged.
RED INDICATOR LIGHT - The battery level is very low, connect the PC to the power supply.

o

POWER STATUS
®© NOT LIT - Power off
GREEN INDICATOR LIGHT - Power on
BLINKING GREEN INDICATOR LIGHT - Stand-by mode.

UNIT ONE 8
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| receiving the kit | recognize the supplied accessories | the Panasonic PC | led indicators and ports | the external CD-R DVD | the ECI module | use the kit |

lateral side — communication ports

| Power outlet
2 Connectors for USB cables
3 Connector for the modem communication cable (type RJ11)

4 Connector for the LAN communication cable (type RJ45)

POWER ON THE PC

The PC autonomy ranges from approx. 3 to 5 hrs; when the BATTERY PACK
STATUS is red it is necessary to power the PC. This can be done in the following
two ways:

- connect the PC to the mains outlet - connect the PC to the cigarette ligher outlet (use the appropriate cable)

UNIT ONE
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| receiving the kit | recognize the supplied accessories | the Panasonic PC | led indicators and ports | the external CD-R DVD | the ECI module | use the kit |

The external CD-R DVD
The unit allows you the reading of CD-ROM and DVD; it also allows the writing of writeable and re-writeable CD's.

POWER ON AND CONNECT THE CD-R

I connect the CD-R/RW unit to the PC through the USB supplied cable 2 the unit is power supplied by the USB: the POWER/BUSY led lights

POWER/BUSY indicator light

connect the supplied
USB cable to the module safety clip
and to the PC, by using a port of the PC

OPEN button

Note: to open the CD-R press the button to open the top cover; it opens only if the unit is
on (POWER/BUSY green led); the CD can be read only if the top cover is closed.
To turn off the unit disconnect it from the PC.

UNIT ONE [0
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| receiving the kit | recognize the supplied accessories | the Panasonic PC | led indicators and ports | the external CD-R DVD | the ECI module | use the kit |

The ECI module (Eltrac Communication Interface)

ECl is an interface module allowing the communication among the vehicle's ECU's and the PC.

WEIGHT 500 ¢ THERMAL TOLERANCE 0-50°C
DIMENSION I75x75x30mm POWER SUPPLY 6-32V

USB and RS232 standard

FLASH MEMORY — 4Mb — RAM IMb CONNECTION INTERFACES :
Bluetooth (optional)

9 KL ISO 92141 lines
VEHICLE INTERFACE 2 channels CAN Bus 2.0B
3 digital outputs - 31/0 PWM

The led indicators on the front view allow to check the communication lines activity with the vehicle and with the PC to which the instrument is connected.

front view = communication led indicators

Led indicators to display the activity of the
communication lines K/L

UNIT ONE [l
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| receiving the kit | recognize the supplied accessories | the Panasonic PC | led indicators and ports | the external CD-R DVD | the ECI module | use the kit |

Led indicators to
display the ECU's
communication activity.
The lower led
indicators display the
CAN lines activity.

The upper led indicator shows
that the ECl is power-supplied.
When blinking the lower led
indicator (RUN) shows that the
ECI module is correctly working.

The three upper led indicators

show the activity of the K/L Led indicators to display the activity of

communication lines. the USB ports (upper led) or serial
The lower led indicator (FAULT) (lower led).
shows the presence of errors on
the K/L lines.

CONNECT THE ECI MODULE

On the ECl module there are the communication ports for the connection to the PC and to the vehicle.

communication ports for the
connection to the PC: from left to
right, serial and USB

communication port for the
connection to the vehicle

UNIT ONE
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| receiving the kit | recognize the supplied accessories | the Panasonic PC | led indicators and ports | the external CD-R DVD | the ECI module | use the kit |

ECI - PC ECI - VEHICLE
I connect the EClI module to the PC by using one of the USB I connect the module to the vehicle by using the vehicle connection cable
supplied cables (mt 1,8 or mt 4,5) Note:

the module is power-supplied by the diagnostic cable; for this reason to work cor-

connect the USB cable (ECI side marked) see p. 3 . .
rectly it must be connected to the vehicle

and picture on the side) to the ECI module:
- remove the holding screws from the EC
module (where present)
- insert the USB connector (ECI marked) into
the correct port

connect the USB cable to the PC:
- insert the USB connector (ECI marked) into
the correct port

ECI mark
2 turnthe PCon
Use the kit
I withdraw the Panasonic Portable PC from its compartment 6 turn the portable PC on (Edl page. 6)
2 release the safety clip oh the front side 7 wait until the operative system loading has been completed
3 connect the PC to the mains outlet by using the power supplier 8 to continue with the registration procedure and the activation of the EASY.
(E2 page. 3) SW read unit 2

power outlet of the Panasonic
portable PC

. . . * M Sw installation
4 withdraw the CD-R/RW unit from its compartment

5 connect the unit to the PC (L page. 4)

UNIT ONE I3
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| receiving the kit | recognize the supplied accessories | the ECl module | use the kit |

The diagnosis system consists of:

ECl interface module

CD containing the activation program

EASY.SW CD

CD with documentation

cables and accessories (ref. Recognize the supplied accessories)
quick guide

registration form

EASY. LIGHT Configuration

CHECK THE KIT CONTENTS

Receiving the kit

It is advisable to carefully check the received kit, which has to contain the above indicated components.

UNIT ONE

* M Sw installation
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* MWl Recognize the supplied accessories
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| receiving the kit | recognize the supplied accessories | the ECl module | use the kit |

Recognize the supplied accessories

OPERATIVE AREA

CABLE FOR VEHICLE CONNECTION USB CABLE A-ECI TYPE WITH EMIFILTER

It allows the connection between
the vehicle diagnosis socket and
the ECl module.

It enables the connection
between the ECl module and
the portable PC.

ACCESSORIES AREA>SELF-DIAGNOSIS AREA

SELF-DIAGNOSIS CONNECTOR

Applied to the ECI throughout the self-diagnosis
procedure, it enables to detect any failures.

UNIT ONE
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| receiving the kit | recognize the supplied accessories | the ECl module | use the kit |

The ECI module (Eltrac Communication Interface)

ECl is an interface module allowing the communication among the vehicle's ECU's and the PC.

WEIGHT 500¢g

DIMENSION [ 75x75x30mm

FLASH MEMORY  4Mb — RAM |IMb

THERMAL TOLERANCE

POWER SUPPLY

CONNECTION INTERFACES

VEHICLE INTERFACE

0-50°C
6-32V

USB and RS232 standard
Bluetooth (optional)

9 KLISO 9141 lines
2 channels CAN Bus 2.0B
3 digital outputs - 31/0 PWM

The led indicators on the front view allow to check the communication lines activity with the vehicle and with the PC to which the instrument is connected.

front view = communication led indicators

Led indicators to display the activity of the
communication lines K/L

UNIT ONE
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| receiving the kit | recognize the supplied accessories | the ECl module | use the kit |

Led indicators to
display the ECU's
communication activity.
The lower led indicators
display the CAN lines
activity.

The three upper led indicators
show the activity of the K/L
communication lines.

The lower led indicator (fault)
shows the presence of errors on
the K/L lines.

CONNECT THE ECI MODULE

On the ECl module there are the communication ports for the connection to the PC and to the vehicle.

UNIT ONE

communication ports for the
connection to the PC: from left to
right, serial and USB

The upper led indicator shows that
the ECl is power-supplied.
When blinking the lower led
indicator (RUN) shows that the ECI
module is correctly working.

Led indicators to display the activity of
the USB ports (upper led) or serial
(lower led).

communication port for the
connection to the vehicle
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| receiving the kit | recognize the supplied accessories | the ECl module | use the kit |

ECI - PC

I connect the ECI module to the PC throughout the USB cable
2 turn the PCon

connect the supplied USB cable to the module and to
the PC, by using a port of the PC

Use the kit
I turn the PCon
2 wait until the Operating System loading has been completed

3 to continue with the registration procedure and the activation of the EASY.
SW read unit 2

UNIT ONE

ECI - VEHICLE

I connect the module to the vehicle by using the vehicle connection cable

Note:

the module is power-supplied by the diagnostic cable; for this reason to work cor-

rectly it must be connected to the vehicle

* M Sw installation
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| use the cd for the first time |

Modus/IT 2000

The diagnosis system consists of:

- BEASY.SW CD
- CD with documentation
- quick guide

Modus Station back

POWER ON THE STATION:
Modus Station/ IT 2000 Tester user insert the power plug in the outlet of
the mains supply

power on the UPS
turn the switch on the | position

CD-R unit

Use the CD for the first time
I power the Modus Station /IT 2000 Tester The Modus Station is now ready for the installation of the new Diagnosis SWV.

2 wait until the System loading has been completed
3 insert the EASY.SW cd into the unit

* M Sw installation
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unit 2
Sw installation

ATTENTION! GENERAL RULES FOR USE

This software may cause chassis movements and/ or engine start-up. The following instructions should always be strictly followed:

Be extremely careful. * check all instruments and ensure the vehicle is parked safely (e.g. handbrake
The user is responsible for the correct use of the EAASY. software so as not to any on, wheels chocked and with gearbox in neutral, etc...)

cause injury to people or damage to items.  ensure that the ECl module is connected to the diagnostic socket of the

The user is also responsible for complying complying with all the rules relating to vehicle on which work is to be carried out

vehicle security and activities in the workshop. . ‘ _
* in case of emergency, disconnect the ECI module from the vehicle or

Carefully read the user manual before using the diagnostic tool and follow the disconnect the LISB cable

instructions displayed on the screen.
* ensure that while using the software, there is nobody near the vehicle you
are working on

 if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of the
workshop

* we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).




SW INSTALLATION

h'" UNITS INDEX

| e.asy configuration | e.a.sy. light configuration | Modus Station / IT 2000 Tester user |

The EAS.Y. diagnosis system is formed of:
a portable PC (Toughbook Panasonic or own + Microsoft Windows 2000 Windows XP Professional or Modus PC)

an instrument used as interface between vehicle and PC (ECI tester or Modus Station / IT 2000 tester)
a SW program (E.ASY) to process data

By combinating the above indicated components 3 different configuration are possible. Select your user configuration type and then follow the
relevant information.

users types: identify your configuration

| e.a.sy. configuration for user Panasonic PC + ECl module + EASY. sw

2. easy. light configuration for user's own PC + ECl module + EASY. sw.

3. Modus Station / IT 2000 Tester + EASY. sw user
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| e.asy configuration | e.a.sy. light configuration | Modus Station / IT 2000 Tester user |

e.a.sy. configuration

user Panasonic PC + EC| module + E.A.SY. sw
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To use the EAASY. diagnosis system + ECl module it is firstly necessary to register the EASY. system in use and ask for the activation code:

Registration

¢ connect to www.eltrac.it

¢ from the main page select the specific section EASY.
¢ select EASY. REGISTRATION

¢ afill-in form is displayed

¢ enter the data required

¢ just click senD to send the filled in form

Caution

the activation code received will be
requested the first time you run the
E.ASY. software.

O

¢ within 48 h from forwarding, the code for activating the E.A.SY. software will be notified to the user e-mail address specified in the form
(" Activation)
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| registration | connection | activating - first time of use | activating - new ECI module | release update |

Registration form

Registration allows you to obtain the activation code. In the registration form you should indicate the customer, logistic and technical information
concerning your EASY. system. In particular you are required to state the following:

SYSTEM CHOSEN

state whether E.A.SY. or E.A.SY. Light, choosing
from the drop-down menu

ACTIVATION REQUESTED

select the corresponding check-box

ECI SERIAL NUMBER

the serial number is type
XX - #H#HH#HHH-HH-HH-HH,
to be found on the back of the ECI module

PANASONIC PC SERIAL NUMBER

the serial number is type
HKX-HH# AKX AKX XXX X
HXXXXHHAHH

technical information about the PC on
which EASY. is to be installed

Modus, 12000, IWT or other, stating the
serial numbers

The registration form must be completed on-line; at the end select the senp button to end the operation.

If you are not able to connect to the above indicated site, print the form contained on the CD. After having
filled in the form, fax it to Eltrac Field Service (+39-11-22309281); this procedure will last more time.
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Connection

|. connect the ECI module to the vehicle using the diagnosis cable

Note
the ECI module is supplied by the diagnosis cable; therefore
it must be connected to the vehicle to be able to work

2. connect the ECI module to the PC, using one of the two USB cables provided
with the module

3. switch the PC on

For further details read the information below indicated:

Recognize the supplied accessories
Sw interface

Bluetooth Device
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| registration | connection | activating - first time of use | activating - new ECl module | release update |

Activation - first time of use of E.A.SY. software + ECI module
The first time the EAA.SY. Diagnosis System release 3.1 is used, it is necessary
to follow the procedure described below:

|. make sure you have received the activation code from Field Service

2. connect the ECI module to the Panasonic PC and to the vehicle using
the USB cable

3. start the Panasonic PC

How to start the Panasonic PC
I. remove the portable Panasonic PC from its housing

2. release the safety catch on the front and lift up the monitor

H

SAFETY CLIP

3. connect the power supply unit to the PC, through the
power socket, and to the mains

4. switch on the portable PC and wait for loading of the
operating system

to switch on the
PC move the
ON button to
the right

_—r
:
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| registration | connection | activating - first time of use | activating - new ECl module | release update |

4. The system asks you to enter the activation code received from Field Service (W Registration);
select the Tick button

O 5. enter the activation code received from Field Service

6. select the REGISTER button; a message confirms that registration has taken place

/. select the cross button to close the
Activation Code window and go back to the
E.ASY. screen

O

8. select the sTor button and restart EASY.

Now all the software functions are available.



SW INSTALLATION
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Activating - new ECI module

The activation procedure is necessary every time you want to use an ECI module that has not yet been paired to the E.ASY. diagnosis system in use;
follow the operations described below:

|. make sure you have requested and obtained the activating code for the ECI module (MM registration)
2. connect the ECI module to the Panasonic PC and to the vehicle using the USB cable
3. start the EASY. software: double click on the EAASY. icon on the PC desktop

4. select the TOOLS>ACTIVATIONS button

5. select the eNTRY button

6. enter the activation code received from Field
Service

. /. select the REGISTER button; ...a message confirms
that registration has taken place

O

8. select the cross button to end activation

9. re-start the E.ASY.
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Activation Codes menu functions

Functions are available for easily handling the activation codes. Selecting TooLs>ACTIVATIONS the activation code window appears which allows access
to the Activation Code management functions:

¢ ENTRY select to enter the activation code received from
Field Service

¢ IMPORT allows you to import the files containing the
activation codes

¢ EXPORT allows you to export the files containing the
activation codes

¢ Remove ECI allows you to deactivate an ECl module activated
previously on the PC in use.

To check which modules are
activated and connected

to the PC in use select the
HELP>INFORMATION button.
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Activation Codes > Entry menu functions

This allows you to enter the activation code received from Field Service

|. select ENTRY
2. select the active field and use the keyboard to enter the activation code
3. select the REGISTER button

4. if the activation code is wrong a message will confirm so

5. select the cross button to close the Activation
Code window and go back to the EASY.
screen

6. re-start the EA.SY. software to make activation

© effective
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Activation Codes > Import menu functions

This allows you to import the files containing the activation codes provided by Field Service or coming from a previous export:
|. create a folder that will hold the files containing the activation codes, for example folder c:myadir
2. copy the files with the activation codes (actCodes:txt and ECls:txt) in the c:myadir folder

3. select IMPORT

4. select the active field and, using the keyboard, enter the folder name
including the path, cmyadir

5. select the IMPORT button
¢ a message confirms that import has taken
place

6. select the cross button to close the Activation
Code window and go back to the EASY.

Q screen

/. re-start the E.ASY. software to make activation effective
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h... UNITS INDEX

| registration | connection | activating - first time of use | activating - new ECl module | release update |

Other functions of the Activation Codes > Export menu

This allows you to export the files containing the activation codes:

|. create a folder that will hold the files containing the activation codes, for example folder c:myadir

). select EXPORT

3. select the active field and using the keyboard, enter the folder name
including the path, c:myadir

4. select the EXPORT button
a message confirms that export has taken place

5. select the cross button to close the Activation
Code window and go back to the EASY.
screen

O O
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Other functions of the Activation Codes > Remove ECI menu

This allows you to deactivate an ECI module activated previously on the PC in use:

|. select rRemovE ECI

2. using the drop-down menu choose the ECI module you want to deactivate

3. select the rRemove ECI button

o 4. select the cross button to close the Activation
Code window and go back to the EASY

O screen
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Release update

If you are updating the E.A.SY. diagnosis software installed on the Panasonic PC to release 3.1,
follow the procedure described below:

|. put CD | of the EASY.software in the CD-R/RW drive (M unit |)> select the CD-R/RW
drive with a double click: the setup.exe application is run automatically; if the operation falils,
examine the contents of the CD and select the Setup.exe file to start set-up

2. select the language in which you want to install the EA.SY. software

3. select the EAA.SY. SOFTWARE RELEASE - CD | INSTALLATION button:

wait...
4. choose the installation language from the drop-down menu and press the ok button
software set-up begins; wait....
5. select the flag corresponding to the language

in which you want to install the EASY. sw;

it is possible to choose more than one
language; continue selecting the NexT button

 ——
E ——
Caution

The exit button, when available, allows you
to EXIT the set-up environment. Q
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wait... a message tells you that it is necessary to insert the second CD; follow the instructions on the screen;

6. press the exiT button; eject CD | and insert /. choose the installation language from 8. select the EA.SY. SoFtwaRE ReLease - CD 2
cD2 the drop-down menu and press the ok INSTALLATION button
button

>

...wait for the end of set-up

9. press the exIT button to exit the set-up environment and eject the CD.
An example for a possible diagnosis path:

Sw interface

Select the EAASY. - SOFTWARE UPDATE UTILITY INSTALLATION button to install the automatic utility update.
Acceptance

Select the ADOBE READER INSTALLATION button to set-up the PDF file reader; it is necessary to consult all the
ECU diagnosis documentation attached.
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e.a.sy. light configuration

user’s own PC + EC| module + E.A.SY. sw.
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Installation of the EA.SY. diagnosis software requires the following operations:

|. registration of the EASY. system

2. set-up of the EASY. software
3. installation of the USB driver of the ECl module, if the PC in use has never been connected to an ECl module:

4. entry of the activation code to enable the PC for use of the ECI module

|. Registration
To use the EAASY. diagnosis system + ECl module it is firstly necessary to register the E.ASY. system in use and ask for the activation code:

|. connect to site www.eltrac.it

2. from the home page go to the specific EASY. section

3. select EASY. REGISTRATION
O 4. a form to be completed on line appears

5. enter the data required

6. select the seND button to
send the completed form

>

Caution

The activation code received will be

requested the first time you run the 7. within 48 h from forwarding, the code for activating the E.ASY. software will be notified to the user
EASY. software. e-mail address specified in the form (M Activation)
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Registration form

Registration allows you to obtain the activation code. In the registration form you should indicate the customer, logistic and technical information
concerning your EASY. system. In particular you are required to state the following:

SYSTEM CHOSEN state whether E.A.SY. or E.A.SY. Light, choosing
from the drop-down menu
5 [y e
ACTIVATION REQUESTED select the corresponding check-box 4 QRPN S P
ECI SERIAL NUMBER the serial number is type MR

XX - #H#HH#HHH-HH-HH-HH, Moater IWCASE 8- WDE
to be found on the back of the ECI module

technical information about the PC on
which E.ASY is to be installed

Modus, IT2000, IWT or other, stating the
serial numbers

The registration form must be completed online; at the end select the send button to end the operation.

If you are not able to connect to the above indicated site, print the form contained on the CD. After having
filled in the form, fax it to Eltrac Field Service (+39-11-22309281); this procedure will last more time
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2. E.A.SY. software set-up

|. put CD | of the EASY. software in the CD-R/RW drive > select the CD-R/RW
drive with a double click: the setup.exe application is run automatically; if the
operation fails, examine the contents of the CD and select the Setup.exe file to
start set-up

2. select the language in which you want to install the EA.SY. software

3. select the EAA.SY. SOFTWARE RELEASE - CD | INSTALLATION button;

wait. ..
4. choose the installation language from the drop-down menu and press the ok button
software set-up begins; wait....
5. select the flag corresponding to the language

in which you want to install the EASY. sw;

it is possible to choose more than one
language; continue selecting the NEXT button

E ——
—_—
Caution

The exit button, when available, allows you
to EXIT the set-up environment. Q
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wait... a message tells you that it is necessary to insert the second CD; follow the instructions on the screen;

6. press the exiT button; eject CD | and insert

CD2.

>

An example for a possible diagnosis path:

Sw interface
Acceptance

ECU diagnosis

/. choose the installation language from 8. select the EASY. SOFTwaRE ReLeAse - CD 2
the drop-down menu and press the ok INSTALLATION button
button

>

...wait for the end of set-up

9. press the exiT button to exit the set-up environment and eject the CD.

Select the EAA.SY. - SOFTWARE UPDATE UTILITY INSTALLATION button to install the automatic utility update.

Select the ADOBE READER INSTALLATION button to set-up the PDF file reader; it is necessary to consult all the
documentation attached.
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Connection

|. connect the ECI module to the vehicle using the diagnosis cable

note
the ECI module is supplied by the diagnosis cable; therefore
it must be connected to the vehicle to be able to work

2. connect the ECI module to the PC, using one of the two USB cables provided

with the module

3. switch the PC on, if necessary

For further details read the information below indicated:

Recognize the supplied accessories
Sw interface

Bluetooth Device

22
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3. ECl module USB driver set-up 4. select the Don't search. | will choose the driver to install;

. L . . . lect the NExT> button t ti
This operation is required only if the PC in use has never been SEISCE TG LN o COMtnUE

connected to an ECI module:

|. check that the ECI module is correctly connected to the PC
via the USB cable

2. the PC acknowledges the presence of a new hardware component;
press the cross button to continue

O
-

3. automatically (Windows XP) the procedure starts to set-up the
driver; select the Install from a list or specific location option;

select the NEXT> button to continue 5. select the HAVE DIsK...> button to continue

:
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6. enter the path: ProgramFilesEltracECIDriverEClsys; 8. driver set-up begins... wait
select the ok button

9. the procedure is completed; press the FINISH button

O

/. select the NEXT> button to continue
|0. the system informs that the new hardware has been correctly
installed; select the cross button to continue

-

| |. re-start the PC.
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4. First activation (first time of use of E.A.SY. software + EC| module)

The first time the E.A.SY. Diagnosis System release 3.1 is used, it is necessary to follow the procedure described below:

|. make sure you have received the activation code from Field Service

2. connect the ECI module to the Panasonic PC and to the vehicle using the USB cable

3. start the PC
4. the system asks you to enter the activation code received from Field Service (M Registration); select the Tick button

5. enter the activation code received from Field Service

6. select the REGISTER button; a message confirms that registration has taken place

/. select the cross button to close the
Activation Code window and go back to the

E.ASY. screen

8. select the stop button and restart EASY.

Now all the software functions are available.
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Activating a new ECl module

The activation procedure is necessary every time you want to use an ECI module that has not yet been paired to the E.ASY. diagnosis system in use;
follow the operations described below:

|. make sure you have requested and obtained the activating code for the ECI module (MM registration)
2. connect the ECI module to the Panasonic PC and to the vehicle using the USB cable
3. start the EASY. software: double click on the EASY. icon on the PC desktop

4. select the TOOLS>ACTIVATIONS button

5. select the eENTRY button

6. enter the activation code received from Field
Service

¢ /. select the REGISTER button; ...a message confirms
that registration has taken place

O

8. select the cross button to end activation

9. re-start the EASY.
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Activation Codes menu functions

Functions are available for easily handling the activation codes. Selecting tools>activations the activation code window appears which allows access
to the activation code management functions:

¢ ENTRY select to enter the activation code received from
Field Service

¢ |MPORT allows you to import the files containing the
activation codes

¢ EXPORT allows you to export the files containing the
activation codes

<&

Remove ECI allows you to deactivate an ECl module activated
previously on the PC in use.

To check which modules are
activated and connected to
the PC in use select the
HELP>INFORMATION button.
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Activation Codes > Entry menu functions

This allows you to enter the activation code received from Field Service

|. select ENTRY
2. select the active field and use the keyboard to enter the activation code
3. select the REGISTER button

4. if the activation code is wrong a message will confirm so

5. select the cross button to close the Activation
Code window and go back to the EASY.
screen

6. re-start the E.AA.SY. software to make activation

© effective

28



h." UNITS INDEX SW INSTALLATION
| registration | EASY sw set-up | connection | ECI driver set-up | first activation | activating new ECI module | release update |

Activation Codes > Import menu functions

This allows you to import the files containing the activation codes provided by Field Service or coming from a previous export:
|. create a folder that will hold the files containing the activation codes, for example folder c:myadir
2. copy the files with the activation codes (actCodes:txt and ECls:txt) in the c:myadir folder

3. select IMPORT

4. select the active field and, using the keyboard, enter the folder name
including the path, cmyadir

5. select the IMPORT button
° a message confirms that import
has taken place

6. select the cross button to close the Activation
Code window and go back to the EASY.

O screen

/. re-start the E.ASY. software to make activation effective
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Other functions of the Activation Codes > Export menu

This allows you to export the files containing the activation codes:

|. create a folder that will hold the files containing the activation codes, for example folder c:myadir

). select EXPORT

3. select the active field and using the keyboard, enter the folder name
including the path, c:myadir

4. select the ExpORT button
a message confirms that export has taken place

5. select the cross button to close the Activation
Code window and go back to the EASY.
screen

O O
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Other functions of the Activation Codes > Remove EC|

This allows you to deactivate an ECI module activated previously on the PC in use:
| select remove ECI
2. using the drop-down menu choose the ECI module you want to deactivate

3. select the remove ECI button

4. select the cross button to close the Activation
Code window and go back to the EASY

O screen
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Release update

If you are updating the E.A.SY. diagnosis software installed on the PC to release 3.1, follow the
procedure described below:
|, put CD | of the EASY. software in the CD-R/RW drive > select the CD-R/RW drive with a

double click: the setup.exe application is run automatically; if the operation fails, examine the
contents of the CD and select the Setup.exe file to start set-up

2. select the language in which you want to install the EA.SY. software

3. select the EAA.SY. SOFTWARE RELEASE - CD | INSTALLATION button:

wait. .. , ,
4. choose the installation language from the drop-down menu and press the ok button
software set-up begins; wait....
5. select the flag corresponding to the language

in which you want to install the EASY. sw;

it is possible to choose more than one
language; continue selecting the NEXT button

R ——
—_—
Caution

The exit button, when available, allows you
to EXIT the set-up environment. Q
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wait... a message tells you that it is necessary to insert the second CD; follow the instructions on the screen;

6. press the exiT button; eject CD | and insert /. choose the installation language from

8. select the E.A.SY. SOFTWARE RELEASE - CD 2
CD2.

the drop-down menu and press the ok INSTALLATION button
button

> >

...wait for the end of set-up

9. press the exiT button to exit the set-up environment and eject the CD.
An example for a possible diagnosis path:

Sw interface

Select the EAASY. - SOFTWARE UPDATE UTILITY INSTALLATION button to install the automatic utility update.
Acceptance

Select the ADOBE READER INSTALLATION button to set-up the PDF file reader; it is necessary to consult all the
documentation attached.

ECU diagnosis
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Modus Station / IT 2000 Tester + E.A.SY. sw user
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E.A.SY. software update - release 3.1
To use the EASY. Diagnosis software - release 3.1 follow the procedure described below:

|. switch on the Modus Station / IT 2000 Tester

2. put CD | of the EASY. software in the CD-R/RW drive; the set-up.exe application is run automatically

3. select the language in which you want to install the E.A.SY. software

4. select the EAA.SY. SOFTWARE RELEASE - CD | INSTALLATION button; wait. ..

[to set-up the new software on an IT2000 tester without CD_R drive, select the copy CD | guttoN ON THE [T2000

before software set-up from [T2000]

E.A.SY. Software Release - CD | \>
Installation /

O> Copy of CD | on 1T2000 >

software set-up begins; wait....

E.A.SY. Software Release - CD | \w.’
Installation /\’
°> Copy of CD | on IT2000 >

N\‘/

TN

Caution
The exit button, when available, allows you
to EXIT the set-up environment.

5. choose the installation language from the drop-down menu and press the ok button

6. select the flag corresponding to the language in
which you want to install the EASY. software; it
is possible to choose more than one language;
continue selecting the NexT button

35



h'" UNITS INDEX

SW INSTALLATION
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wait... a message tells you that it is necessary to insert the second CD; follow the instructions on the screen;

/. press the exiT button; eject CD| and insert
CD2.

E.A.SY. Software Release - CD | \>
Installation /

O> Copy of CD | on IT2000 >

=

T.ANS W

@ Exit

An example for a possible diagnosis path:

Sw interface
Acceptance

ECU diagnosis

8. choose the installation language from

9. select the E.AA.SY. SoFrwaRE RELEASE - CD 2

the drop-down menu and press the ok INSTALLATION button

button
E-A.S)iSoftwarc|Release LICDR \‘> E.A.SY. Software Release - CD 2 \
Installation / Installation )
o> Copy of CD 2 on 1T2000 > o
E.A.SY. Software Update E.A.SY. Software Update
Utility Installation Utility Installation
os Adobe Reader > o> Adobe Reader >
( /
) Exi
- - & )
( /

TN WS

Copy of CD 2 on IT2000

T . NS

...wait for the end of set-up

[to set-up the new software on an IT2000 tester without CD_R drive, select the copy CD 2
button oN THE IT2000 before software set-up from [T2000]

| 0. press the exiT button to exit the set-up environment and eject the CD.

Select the EAASY. - SOFTWARE UPDATE UTILITY INSTALLATION button to install the automatic utility update.

Select the ADOBE READER INSTALLATION button to set-up the PDF file reader; it is necessary to consult all the
documentation attached.
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Sw interface

ATTENTION! GENERAL RULES FOR USE

This software may cause chassis movements and/or engine start-up. The following instructions should always be strictly followed:

Be extremely careful. . .
’ - check all instruments and ensure the vehicle is parked safely

The user is responsible for the correct use of the EASY. software so as not (e.g: handbrake on, wheel chocked and with gearbox in neutral, etc...)

to any cause injury to people or damage to items. - ensure that the ECl module is connected to the diagnostic socket of the
vehicle on which work is to be carried out

- in case of emergency, disconnect the EClI module from the vehicle or

. . , disconnect the USB cable
Carefully read the user manual before using the diagnostic tool and follow _ensure that while using the software, there is nobody near the vehicle you

the instructions displayed on the screen. are working on

The user is also responsible for complying with all the rules relating to
vehicle security and activities in the workshop.

- if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of
the workshop

- we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).
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The E.AASY. software interface is designed to facilitate access to tools, view functions and make diagnostic procedures clear and adaptable to various needs.
All windows follow the same design with additional features which depend on the specific working environments.
Each window presents three main areas to which specific functions are univocally associated:

- Keys Area
- Title Area

- Operative Area
B

A: Keys Area
B:Title Area
C: Operative Area

The Keys area contains Keys for accessing the operative environments and the functions to which they are associated.
The Title area shows the selected function under test and previous choices by which you arrived.

The Operative area contains available system and function list referred to the intervention area.

* M Sw interface
* M Acceptance

* W ECU diagnosis

UNIT 3
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| to go from one environment to another | detail of buttons area

To go from one environment to another
I the Start Window shows the GROUP

Start Window: it is possible to select a new vehicle
(W illustrated below) or to choose it from the
DataBase (L4 unit 4 - acceptance)

2 select the GROUP, the CATEGORY, the CLASS and the SYSTEM
under test to which the vehicle belongs

Window Choose Vehicle

Observe the Lists area: green identifies a pull-
down menu; he electronic system has been
initialised; yellow identifies a selected item in a
pull-down menu.

Select the CATEGORY and then press the
NAVIGATION key to proceed.

Select the SYSTEM and then press the
NAVIGATION key to proceed.

UNIT 3

NAVIGATION KEYS

They allow you to go from one
environment to another. Enabled
keys are displayed in green and

disabled keys are displayed in

grey

NAVIGATION ke NAVIGATION key
FORWARD enabled  BACK enabled

»

NAVIGATION ke
FORWARD disabled

BROWSE KEY

QIERS

To scroll long lists which cannot
be contained in a single window.

DATABASE KEY

[ ommse |

It allows you to access the Data-
base environment.
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3 select the SYSTEM to which the vehicle belongs and then press the NAVIGATION key (it is enabled and shown in green)

4 the window Choose Activity appears; it is here possible to choose from four lists:

window Choose Activity

it is now possible to choose:
- diagnosis

- test

- programming
- specific functions

The working environment
(diagnosis, test, program-
ming and specific functions)
is characterised by the possi-
bility of going from one activ-
ity to another at any time by
pressing the corresponding
keys.

For further details read the information below indicated: * |

* W ECU diagnosis

UNIT 3 3
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Detail of Keys area

In the Start Window the Keys area contains the Keys for accessing the functions which are always available:

STOP key
To quit EA.SY. application at any time.

UTILITIES l<ey
When selected the Key background will be yellow and allows you to
access a menu.

RELEASE NEWS key
It allows you to know the Release News.
IGNITION KEY OFF key
TELESERVICES key ‘ . ACTIVE
It allows you to access the remote connections services. IGNITION key E
To operate vehicle ignition

SELECT LANGUAGE key . . . .
To change the language; restart the application to directly via the diagnostic tool
5 guage, PP (in vehicles where fitted) IGNITION KEY OFF key

make the setting operationdl. Two positions (stop and mar) < I
and three states (enabled stop, E@
disabled stop, enabled mar) are

COMMUNICATION key possible

It indicates that the communication with the ECU is active or that the ECU is not present IGNITION KEY ON key

(no ecu). O ACTIVE
The lower leds indicate the communication state of the electronic system as shown below: L ‘

Square LEDs: two states (green/red); green indicates that communication with the electronic

system has been initialised; if red indicates the communication has been interrupted.
Rectangular LEDs: blinking indicate that data exchange between electronic

system and diagnostic system is in progress. 1o Ecu

N — * » ECU diagnosis

UNIT 3 4
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In the Start Window select the GROUP and the CATEGORY; by pressing the NAVIGATION key FORWARD it is possible to access the next window.
New icons appear in the Keys area for accessing specific functions:

0 &

011001
100100

Y

011001
100100

UNIT 3

VEHICLE key
It allows you to return to the Vehicle Selection screen page.

ELECTRONIC CONTROL UNITS key
It allows you to access the Electronic Ecu’s environment.

The key appears on a yellow background (default status, environment
Electronic Control Units enabled) or on a grey background (environ-

ment Electronic Control Units disabled).

If you want to work at the same time with more Ecu’s, select the key

ENVIRONMENT ELECTRONIC ECU'S>ADD ECU.

ELECTRICAL DIAGRAMS key

It refers to a CLASSES list for which an electrical diagram is available.
The key appears on a yellow background (environment Electrical Dia-
grams enabled) or on a grey background (environment Electrical Dia-

grams disabled).

To enter the Electrical Diagrams environment select the key ELECTRICAL

DIAGRAMS AREA.

REPORT key
It allows you to access the Report environment.

The key appears on a yellow background (environment Report ena-

bled) or on a grey background (environment Report disabled).
To access the report environment select the REPORT key.

ON LINE

GUIDE TO DIAGNOSIS key

[t allows you to access the environment Guide to

Diagnosis (only available for some ranges). ?
It is available in the Electrical Control Units

environment.

ON/OFF-LINE key

It can be on-line or off-line.

The on-line key indicates that the E.A.SY. SW uses the
ECI/PC module connection.

ON/OFF-LINE key

The off-line key indicates the E.A.SY. SW is working in
simulated mode.

To change the status select the key.
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unit 4

acceptance
ATTENTION! GENERAL RULES FOR USE
This software may cause chassis movements and/or engine start-up. The following instructions should always be strictly followed:
Be extremely careful. . L

- check all instruments and ensure the vehicle is parked safely

The user is responsible for the correct use of the EASY. software so as not (e.g: handbrake on, wheel chocked and with gearbox in neutral, etc...)
to any cause injury to people or damage to items. - ensure that the ECl module is connected to the diagnostic socket of the

vehicle on which work is to be carried out
- in case of emergency, disconnect the EClI module from the vehicle or

. . , disconnect the USB cable
Carefully read the user manual before using the diagnostic tool and follow _ ensure that while sing the software, there is nobody near the vehicle you

the instructions displayed on the screen. are working on

The user is also responsible for complying with all the rules relating to
vehicle security and activities in the workshop.

- if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of
the workshop

- we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).
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Environment DataBase

From the EASY. Start Window it is possible to select a new vehicle or to select it from the DataBase |

I select the ARCHIVE button: you access the DataBase environment (it contains the list of accepted vehicles)

2 the DataBase environment shows:

* the list of accepted vehicles (identified by DATE, VIN, CUSTOMER and
REGISTRATION NO)

* the NAVIGATION button FORWARD
* the NAVIGATION button BACK

( ) * the REPORT button (enabled after selecting a vehicle)

3 select a vehicle from the list (the background is yellow); it is possible:
* to analyse vehicle data (report button)
* to return to the start window (NAVIGATION button BACK)
* to start again the diagnosis procedure on the vehicle (NAVIGATION button FORWARD)

-

[. This unit describes how to choose a vehicle from the DataBase; for the selection of a new vehicle unit 5 - ECU Diagnosis.

UNIT 4
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Environment Report
In the Report environment the sheet of the vehicle under test has been saved: the vehicle has been accepted.
You access the Report environment in the following ways:

- from the DataBase environment by selecting the required vehicle and the report button

- from the Buttons area at any time by selecting the corresponding button

-

_ Report environment buttons
The Report environment presents three areas:

KEY SAVE

( ) * VEHICLE DATA: identification vehicle data (VIN, univocal and mandatory, PIC, engine e

serial number, engine type, etc.); the fields can be always changed (with the exception
of the VIN code) it allows you to save the
vehicle sheet (to accept it)

* DIAGNOSIS REPORT: summary of all performed diagnosis operations

* PROGRAMMING REPORT: summary of all performed programming operations KEY AUTOMATIC

ACCEPTANCE

F;MMCWM
Note: it is possible to access the three areas by using the

buttons displayed on the picture it allows you to read the VIN
directly from the engine ECU
(enabled only if the
communication is active)

UNIT 4 2
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Acceptance

The acceptance (sheet saving) is mandatory when important operations are performed (read or cancel faults memory, programming).

I read or cancel the faults memory or carry out a programming and then select from
the corresponding environment the REPORT button; you enter the Report environment

2 enter data

3 confirm the operation by selecting the TICK
icon

4 save the sheet by selecting the SAVE button

5 from the Buttons area select the button of
the operation you want to perform

UNIT 4

When you read or cancel the faults memory or carry out a programming it is NOT
possible to return directly to the window Choose Vehicle; by selecting the vehicle button
the following windows are displayed:

A select the TICK icon; the Report environment appears

B enter data: the VIN is mandatory

C confirm the operation by selecting the TICK
icon

D save the sheet by selecting the SAVE button

it is now possible to return to the window Choose Vehicle
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Automatic Acceptance
From the Report environment it is also possible to accept the vehicle automatically (the system enters the VIN).
Note: this operation is only possible if the communication with the system has been activated.

I read or cancel the faults memory or carry out a programming and then select from the corresponding environment the REPORT button

2 you enter the Report environment

3 select the button AUTOMATIC ACCEPTANCE

4 EASY.system presents a pop-up window where to select the automatic or the manual acti-
vation of the ignition key; select the required mode

5 confirm the displayed message by pressing the TICK icon; wait until the ECU is ready

6 by means of the automatic acceptance the system tries to communicate with the engine ECU of the vehicle (or other ECU'’s containing vehicle data) or to read
the following vehicle information:

~VIN'

- PIC

-- Engine type

-- Engine Serial Number

7 select the SAVE button

I. the VIN must be univocal in the DataBase; if the VIN of the vehicle you are saving is already present in the DataBase a window appears asking the following:“The VIN Code of this vehicle
has been already stored in the DataBase. If you continue these data will be added to those already present”. It is possible to CONFIRM the operation (the data of the new vehicle will be
added to sheet already present in the DataBase) or to CANCEL (the entered VIN must be changed in order to save the operation)

UNIT 4 4
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unit 5

ECU diagnosis

ATTENTION! GENERAL RULES FOR USE

This software may cause chassis movements and/or engine start-up. The following instructions should always be strictly followed:

Be extremely careful. . L
’ - check all instruments and ensure the vehicle is parked safely

The user is responsible for the correct use of the EASY. software so as not (e.g: handbrake on, wheel chocked and with gearbox in neutral, etc...)

to any cause injury to people or damage to items. - ensure that the ECl module is connected to the diagnostic socket of the
vehicle on which work is to be carried out

- in case of emergency, disconnect the EClI module from the vehicle or

. . , disconnect the USB cable
Carefully read the user manual before using the diagnostic tool and follow _ ensure that while sing the software, there is nobody near the vehicle you

the instructions displayed on the screen. are working on

The user is also responsible for complying with all the rules relating to
vehicle security and activities in the workshop.

- if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of
the workshop

- we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).
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I select the GROUP, the CATEGORY, the CLASS and the SYSTEM under test to which the vehicle belongs
2 press the NAVIGATION button FORWARD (enabled, shown in green)

3 the window Choose Activity appears; it is here possible to choose from four lists:

The working environment

window Choose Activity (diagnosis, test,

it is now possible to choose: programming and specific

- diagnosis functions) is characterised by
_test the possibility of going from

one activity to another at

- programmin,
prog s any time by pressing the

- specific functions

Q corresponding buttons.

4 the present Repair Guide describes the DIAGNOSIS environment and the specific functions to which it is associated:
three possible activities can be carried out in the DIAGNOSIS environment:

- Identification Code Reading

- Read Faults memory
- Parameters Reading * M Sw interface

Each function associated to the Diagnosis is described below.

UNIT 5
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Identification code reading

I to access the Read Identification environment select the item Read Identification from the DIAGNOSIS list and then press the NAVIGATION button FORWARD

2 EASY system presents a pop-up window where to select the automatic or the manual activation of the ignition key; select the required mode; the KEY button
is disabled

under the automatic mode all activation
of the ignition key are controlled by the
diagnosis instrument (KEY button working)

two new buttons appear:
the CROSS key

under the manual mode all activation of

the ignition key are controlled by the
operator) it allows you to cancel the

running operation

the TICK key

3 confirm the new message by pressing the TICK icon; wait until the ECU is ready; the general information about the

electronic system under test is read: . . ,
it allows you to continue with

the running operation; it is
necessary to confirm the
displayed message

- identification code
- HW version

- SW version

- production date
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Identification code reading

After identification code reading it is possible to carry out other activities (MWistep 4) or to return to the window Choose vehicle (mistep 6).

4 to access the other activities from the environment Identification Code 6 to exit the diagnosis of the vehicle under test select the button ECU's
Reading, select the CHOOSE ACTIVITIES buttons AREA>ECU UNDER TEST>CANCEL

the CHOOSE ACTIVITIES buttons are
shown in yellow when selected

* M Sw interface

5 choose an activity; the system automatically access the selected activity * MIAcceptance
without showing a warning message

UNIT 5
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| identification code reading | multitasking option | ignition key button modes - ON-LINE / OFF-LINE |

Multitasking option

E.ASY. introduces a very important news: it is possible to associate more ECU's to the family of vehicle under test.

ADD AN ECU

It is possible to interrupt the diagnosis with an ECU and to start the procedure with another one.
I select the button ECU'S AREA>ADD ECU; the Choose Vehicle window will appear, where you can select the desired ECU

the selected ECU appears in the list of connected ECU's

MANAGING MORE ECU'S

It is possible to operate with two or more connected ECU's at the same time.
I select the button ECU'S AREA>DESIRED ECU

The activity remains interrupted for the not selected ECU's and can be started again at any time.

CANCEL AN ECU

it is possible to stop the activity on one of the connected ECU's.
I select the button ECU'S AREA>REQUIRED ECU>CANCEL
2 select the required ECU

UNIT 5
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Ignition Key Button Modes — ON LINE/OFF LINE
At the system start up the ON/OFF button is ON-LINE if the ECI module is activated and connected to the PC, otherwise is disabled (OFF-LINE).

ON LINE MODE

The ON-LINE mode is possible for both the automatic and manual activation; the ignition key window appears after selecting a function (EX Identification Code
Reading).

The automatic activation depends on the type of vehicle; make sure the vehicle supports the function before selecting automatic mode.
I after selecting the automatic mode a test procedure is carried out

2 a window appears asking to switch the ignition off

3 amessage warns that the vehicle chassis may move

The EAASY. SW activates the ignition key and displays a screen page in which it asks to check the dashboard; if it is turned “on” the diagnosis procedure can be
continued; otherwise the system asks for position of the key to ON in manual mode.

The manual mode activation has been described in the previous pages (see Identification Code Reading).

Manual and automatic mode:

I before ignition key activation a message is always displayed: request (manual mode) or warning (automatic)

2 when the ECU is cancelled a message indicates that it is necessary to interrupt the communication and then to confirm the operation

3 the chosen mode remains until the vehicle under test is changed

OFF LINE MODE

The basis diagnosis is simulated and it is possible to read some information about the electronic system under test.

UNIT 5 5
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Read Faults Memory

I to access the Read Faults Memory environment select the item Read Faults Memory from the list DIAGNOSIS and then press the NAVIGATION button FORWARD

2 EASY system presents a pop-up window where to select the automatic or the manual activation of the ignition key; select the required mode; the key button
is disabled

3 confirm the new message by pressing the TICK icon; wait until the ECU is ready; the list and faults type occurred during the working are displayed

There are two types of failures:
- Failures present during the reading procedure (red)

- Intermittent failures not present during the reading operation but which
occurred at least once before (black)
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ECU DIAGNOSIS

| read fautts memory | detail of buttons area of the faults memory area | how to get information about a fault |

detail of Buttons area of the Faults Memory area

New icons appear in the window Read Faults Memory for accessing specific functions:

on ﬂ
OFF

o ﬂ
OFF

Faults

Environmental
Conditions

ON key

the communication between the system and the ECU is active: select the but-

ton to interrupt the reading
it performs again the Faults Reading; it updates the ECU communication

OFF key
the communication with the ECU has been interrupted;
select the button to start again the electronic system reading

CANCEL FAULTS MEMORY key

it cancels the faults selected in the list; it is possible to cancel a fault at a time;

the cancel operation will be effective when you confirm it by pressing the TICK
icon displayed in the next pop-up-window

FAULTS key
it allows you to access the Faults environment; it can be yellow (the faults list
is displayed) or green (environment Faults disabled)

ENVIRONMENTAL CONDITIONS I<ey
This is used to examine environmental conditions when the failure occurred.
it can be green (default status) or yellow (when selected)

Repair Guide:

&
[ |

- >
REPAIR GUIDE key

it gives an analysis of the fault selected from the list; in particular other
information (blink code, failure code and fault mode) is available

PRINT key
it allows you to print the displayed window

SAVE REPORT key

it allows you to save the report of carried out operations

it is also possible to access it from the Report environment (button diagnosis
report)

To go from one function to another (faults, environmental conditions, troubleshooting) select the corresponding button.

Operations like Read and Cancel Faults Memory are very important: they are automatically stored and need the vehicle acceptance (Edl unit 4 - acceptance).
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how to get information about a fault

|
ular the following information is available:

- the fault
- the signal type
- the repetition type

Note: the button FAULTS appears on yellow

interrupt the communication with the ECU (button ON/OFF) and select an item from the FAULTS LIST: the fault is described in the below blank area; in partic-

The Cancel Faults Memory
deletes from the ECU faults
memory all faults which are
not present at the moment;
if a fault is PRESENT on the
vehicle, it remains always

K it is sel
background because it is selected displayed.

2 select the button ENVIRONMENTAL CONDITIONS

it examines the present environmental
conditions at time of the fault

3 select the REPAIR GUIDE button; the following information is available:
- the blink code

- the failure code (DTC)
- the failure mode (FMI)

UNIT 5

Note: the ENVIRONMENTAL CONDITIONS button appears on
yellow background, because it is selected; select the faults
button to return to the Faults List

Note: the REPAIR GUIDE button is shown in yel-
low because it is selected
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Parameters Reading

I to access the Parameters Reading environment select the item parameters reading from the DIAGNOSIS List and then press the NAVIGATION button FORWARD

2 EASY system presents a pop-up window where to select the automatic or the manual activation of the ignition key; select the required mode; the KEY button
is disabled

pay close attention to the displayed
messages and wait

3 confirm the new message by pressing the TICK icon; wait until the ECU is ready; the values assumed by parameters are read

two new icons appears on the window;
their function is described below
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ECU DIAGNOSIS

| parameters reading | detail of parameters buttons area |

detail of parameters buttons area

New icons appears on the window Parameters Reading for accessing specific functions:

oN ﬂ ON I<ey
ol the communication between the system and the ECU is active:

select the button to interrupt the reading

- OFF key
oFFﬂ the communication with the ECU has been interrupted;
select the button to start again the electronic system reading

GROUPS key
it opens the window GROUPS, a list of parameters group; to access a group select it from the list
(shown in yellow)

confirm by pressing the OK button; the selected
group of parameters can be accessed

CUSTOMIZE GROUPS key
cemesces | it gllows you to create new customized parameters, identified by the desired parameters

PARAMETERS ACQUISITION key
Parameters . . .
it allows to record the trend in time of the measurable parameters

In the next page the function of the button CUSTOMIZE GROUPS is described.

UNIT 5
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ECU DIAGNOSIS
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I select the button CUSTOMIZE GROUPS; a new window appears; select the button NEw FOLDER

< o

2 to describe the group you want to create; confirm by pressing the TICK icon, the GROUPS window
appears and in the list the name of the
created group appears

3 the new group is empty; return to PARAMETERS GROUP; select a group and the desired parameters
(a multiple selection is possible)

4 return to the button CUSTOMIZE GROUPS, select the just created group; the button ADD PARAMETER is
enabled, select it; the system add to the group the chosen parameter

UNIT 5

NEW FOLDER key

it allows you to create a new parameters group

CANCEL GROUP key

®

it cancels the selected group from the list
it can be disabled (default) or enabled (if the
group to be cancelled is selected)

ADD PARAMETERS key

e

it allows you to add in the created group one or
more parameters, which have been previously
selected from the other group

it can be disabled (default) or enabled (if the
parameters to be added are selected)

CANCEL PARAMETERS key

F=

it allows you to cancel from the created group
one or more parameters, which have been
previously selected

it can be disabled (default) or enabled (if the
parameters to be cancelled are selected)
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programming
ATTENTION! GENERAL RULES FOR USE
This software may cause chassis movements and/or engine start-up. The following instructions should always be strictly followed:
Be extremely careful. * check all instruments and ensure the vehicle is parked safely (e.g. handbrake
The user is responsible for the correct use of the EA.SY. software so as not on, wheels chocked and with gearbox in neutral, etc....)
to any cause injury to people or damage to items. * ensure that the ECl module is connected to the diagnostic socket of the
The user is also responsible for complying complying with all the rules relating vehicle on which work is to be carried out
to vehicle security and activities in the workshop. * in case of emergency, disconnect the ECl module from the vehicle or
Carefully read the user manual before using the diagnostic tool and follow disconnect the USB cable
the instructions displayed on the screen. * ensure that while using the software, there is nobody near the vehicle you

are working on

 if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of the
workshop

* we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).
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To access the programming area of the ECU under test proceed as follows:

select the GROUR the CATEGORY;
select the FORWARD NAVIGATION key (it is active, displayed in green)

select the CLASS and the System under test to which the vehicle belongs;
select the FORWARD NAVIGATION key (it is active, displayed in green)

select the PROGRAMMING option from the
PROGRAMMING list; select the FORWARD
NAVIGATION key (it is active, displayed in green)

FORWARD NAVIGATION |<ey

[t is possible to carry out a PROGRAMMING only
in online mode. In case of error check the
connections ECU/ECI/EASY
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select the ignition key management (automatic/manual):
if the electronic vehicle under test is fitted with this function, select the AutoMATIC key

E.ASY. shows the running activities
the ignition key ON is automatically activated

the connection to the ECU starts

read the displayed messages and select the green Tick icon to continue

at the end the system permits access to the Programming environment;
the components list is displayed, on which tests can be carried out

During the programming do not disconnect the USB cable.
Before carrying out the ECU programming verify the
charge left in the computer's battery.

[t is recommended to plug the PC in (connect it to the

vehicle or to the mains supply). Programming

environment
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Programming environment

It is possible to use specific functions, by selecting the corresponding key:
Data Reading
Change the configuration
Programming

PTO (only for the EASY full version SW)

The available function types are determined according to the type of ECU under test.

SUBTITLE area

TITLE area
KEYS area

In this case the cross key bring back to the
Activity environment.

The Keys area contains the buttons for accessing the functions specific for the Programming environment.

The Title area contains the work-path.

The Subtitle area contains the name of the current area and the cross key.

CANCEL key

)

if enabled, select to re-establish a

configuration

if enabled, select to print a report

PRINT key

NAVIGATION Keys

if enabled, select to move
between different environments

&3

id enabled, select to cancel an
operation

CROSS key
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Data Reading

This is used to view the data concerning the ECU and the respective programming state;

tampering attempts are shown. SCROLL keys

station type and number

ECU software release

programming date A
v

if enabled, select to scroll the list
step by step

FAST SCROLL keys

ECU’s data.

Please use the scroLL keys to view all the

The system views the following data classes: if enabled, select to scroll the list
supplying data step by step
factory data (never updated)

service data (updated after each programming event)
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Programming > Change the configuration

This is used to edit some ECU options, e.g. to install different elements which respect to the original version.
The type of intervention and their configuration possibilities depend on the type of ECU and can be univocally identified by the alphanumeric code

which appears using the ECU'’s data reading function.
To modify the parameters you can:

select the given options (ie YES/NO) from a menu-list;
select a numerical value by using the pLUS-MINUS keys available beside the active area

select the NAVIGATION FORWARD key to continue

a summary screen appears: select the NAVIGATION
FORWARD key to continue

a summary label appears on a new screen: select
the PRINT key to print the label
select the NAVIGATION FORWARD key to continue

keys PLUS-MINUS keys PLUS-MINUS FAST

if enabled, they allow to adjust if enabled, they allow to adjust
(increase or decrease) the value. (increase or decrease) the value.



| the consultation can be started | programming environment | data reading | programming > change the configuration |

Programming > ECU Programming

This is used to program elements of the ECU under test in encoded mode.

The ECU programming procedure starts by entering the alphanumeric programming code using the keyboard on the screen.

select the active field and enter the alphanumeric code

select the NAVIGATION FORWARD key

A summary label appears on a new screen:
select the PRINT key to print the label

select the NAVIGATION FORWARD key

[t is not possible to select the STOP key in the Programming environment: you are
not allowed to interrupt the program during a programming procedure.
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unit 7
active diagnosis

ATTENTION! GENERAL RULES FOR USE

This software may cause chassis movements and/or engine start-up. The following instructions should always be strictly followed:

Be extremely careful. * check all instruments and ensure the vehicle is parked safely (e.g. handbrake
The user is responsible for the correct use of the EASY. software so as not on, wheels chocked and with gearbox in neutral, etc....)

to any cause injury to people or damage to items. * ensure that the ECl module is connected to the diagnostic socket of the
The user is also responsible for complying complying with all the rules relating vehicle on which work is to be carried out

to vehicle security and activities in the workshop. * in case of emergency, disconnect the ECl module from the vehicle or
Carefully read the user manual before using the diagnostic tool and follow disconnect the USB cable

the instructions displayed on the screen. * ensure that while using the software, there is nobody near the vehicle you

are working on

 if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of the
workshop

* we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).
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To start the Active Diagnosis

|. select the GROUR the CATEGORY;
select the FORWARD NAVIGATION key (it is active, displayed in green)

2. select the CLASS and the SYSTEM under test to which the vehicle belongs;
select the FORWARD NAVIGATION key (it is active, displayed in green)

3. from the SPECIFIC FUNCTIONS list select
the option Active Diagnosis;
select the FORWARD NAVIGATION key
(it is active, in green displayed)

O

Caution O

[t is possible to carry out an ACTIVE DIAGNOSIS
only in online mode. In case of error check
the following connections ECU/ECI/E.A.SY.




h." UNITS INDEX ACTIVE DIAGNOSIS
| to start the Active Diagnosis | Active Diagnosis environment | Active Diagnosis examples |

4. select the ignition key management (automatic/manual):
if the electronic vehicle under test is fitted with this function, select the automatic key

¢ EASY. displays some information about the activity in progress

¢ the ignition key ON is automatically activated

© ¢ the ECU connection starts

5. read the displayed messages and select the green Tick icon to continue

6. at the end the system permits access to the Active Diagnosis environment;
the components list is displayed, on which tests can be carried out

Active Diagnosis Environment
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| to start the Active Diagnosis | Active Diagnosis Environment | Active Diagnosis examples |

Active Diagnosis Environment

The components of the selected electronic system are indicated in a list; use the browse keys to display all the elements of the list
|. select the COMPONENT on which the test will be carried out

2. select the FORWARD NAVIGATION key to continue and carry out the test

components:

HELP key
selectable list

if selected it shows
information about the
electronic system under
test; information about the
GUIDE TO THE DIAGNOSIS are
not provided.

BROWSE key

BACK NAVIGATION |<ey

Oﬁ FORWARD NAVIGATION key

The Back NAVIGATION key allows you to move one step back; if selected at this level it allows you to exit the
Active Diagnosis environment.
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| to start the Active Diagnosis | Active Diagnosis Environment | Active Diagnosis examples |

Active Diagnosis examples

The type of the electronic system under test determines the
components type where it is possible to carry out an active
diagnosis.

Different tests are prepared for different components.
Significant examples are indicated below.

EDC Warning light

|. select the sTART key and follow the instructions

2. select the BACK NAVIGATION key to choose another test

START key

-

BACK NAVIGATION

Oi key

Fuel Pressure Set

Check the security
regulations.

The on-screen
displayed instructions
help during the test
execution.

At the end of the
operation select the
BACK NAVIGATION key to
choose another test

Fuel Pressure Set

The on-screen
displayed instructions
help during the test
execution.

At the end of the
operation select the
BACK NAVIGATION key to
choose another test.
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unit 8
engine test

ATTENTION! GENERAL RULES FOR USE

This software may cause chassis movements and/or engine start-up. The following instructions should always be strictly followed:

Be extremely careful. * check all instruments and ensure the vehicle is parked safely (e.g. handbrake
The user is responsible for the correct use of the EASY. software so as not on, wheels chocked and with gearbox in neutral, etc....)

to any cause injury to people or damage to items. * ensure that the ECl module is connected to the diagnostic socket of the
The user is also responsible for complying complying with all the rules relating vehicle on which work is to be carried out

to vehicle security and activities in the workshop. * in case of emergency, disconnect the ECl module from the vehicle or
Carefully read the user manual before using the diagnostic tool and follow disconnect the USB cable

the instructions displayed on the screen. * ensure that while using the software, there is nobody near the vehicle you

are working on

 if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of the
workshop

* we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).
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| to start an Engine Test | Engine Test environment | Help key in the engine test environment |

To start an Engine Test

| select the GROUR the CATEGORY;
select the FORWARD NAVIGATION key (it is active, displayed in green)

2. select the CLASS and the SYSTEM under test to which the vehicle belongs;
select the FORWARD NAVIGATION key (it is active and displayed in green)

3. select the Engine Test option from the Specific
Functions list; select the FORWARD NAVIGATION
key (it is active, in green displayed)

Caution

It is possible to carry out an engine test only in online Q
mode.

In case of error check the ECU/ECI/E.A.SY. connections. 4. you access the Engine Test environment where the list of available tests is displayed
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| to start an EngineTest | Engine Test environment | Help key in the engine test environment |

Engine Test environment

It is possible to carry out a test of a specific function, to read the set parameters values or to consult the tests results of previous tests.
The options are displayed in a selectable List:

I. engine test: select to carry out the test; the electronic system under test determines the components type on which the test can be carried out.
2. stored results: select to analyze the results of previous tests which have been saved in a file

3. read parameters: select to carry out the test of set parameters

available options:
selectable List

HELP key

if selected, it provides
information about the
tests; information about
the guide to diagnosis are
not provided

BACK NAVIGATION |<ey

FORWARD NAVIGATION key

The BACK NAVIGATION key allows you to move one step back; if selected at this level it allows you to exit the Engine Test environment.
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ENGINE TEST

| to start an EngineTest | Engine Test environment | Help key in the engine test environment |

Engine Test

|. select the Engine Test option

2. select the test you want to carry out or the Check Up option

3. press the FORWARD NAVIGATION key (enabled, shown in green)

FORWARD NAVIGATION |<€>/

the system displays information about the activities in progress
the ignition key ON is automatically activated

the ECU connection starts

. read the displayed messages and select the Tick icon to continue.

The on-screen displayed
instructions help during
the test execution.

At the end the system
displays the results.

Select the BACK NAVIGATION
key to choose another

O test



ENGINE TEST

h'" UNITS INDEX

| to start an Engine Test | Engine Test environment | Help key in the engine test environment |

Stored Results
|. select the Stored Results option

2. select the test for which you want to analyse the saved data of a previous test

3. press the FORWARD NAVIGATION key (enabled, shown in green)

The requested data are showed in the Stored Data window.

PRINT key

it prints the displayed
data

SAVE key
saves on file the
displayed data

UP/DOWN key

to scroll up and down
long lists which cannot
be contained in a single
window

. FORWARD NAVIGATION key
Stored Results Window |

BACK NAVIGATION key
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ENGINE TEST

| to start an Engine Test | Engine Test environment | Help key in the engine test environment |

Read Parameters

|. select the Read parameters option to carry out an interactive test of set parameters

Parameters Acquisition

=

coolant temperature

fuel temperature

injected fuel

Engine rpm

battery voltage

accelerator pedal position

advance injection

rail pressure

O 0N |l w|N

Vehicle speed

[y
o

boost pressure

2. press the FORWARD NAVIGATION key (enabled, shown in green)

¢ the system displays information about the activities in progress

¢ the ECU connection starts

3. after the connections with the ECU the parameters acquisition starts

O

EMERGECY button

in case of emergency press it to
stop the engine and interrupt
every activity.

Select the BACK NAVIGATION key to return to the acquisition and choose another activity.
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| to start an Engine Test | Engine Test environment | Help key in the engine test environment |

The help key in the engine test environment

|. select the HELP key

2. if necessary, the system requires to select the used engine type

3. select the engine type; you access the help
4. select the test type for which you want to

read the help

5. select the BACK NAVIGATION key to

exit the help.
engines
For each test some information is given about

¢ how to carry out the test
¢ the results estimate
¢ the intervention to be carried out when a

value exceeds the normal range BACK ey PACK NAVIGATION ey

& select to consult another help select to exit the help
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electrical diagrams

ATTENTION! GENERAL RULES FOR USE

This software may cause chassis movements and/or engine start-up. The following instructions should always be strictly followed:

Be extremely careful. * check all instruments and ensure the vehicle is parked safely (e.g. handbrake
The user is responsible for the correct use of the EA.SY. software so as not on, wheels chocked and with gearbox in neutral, etc....)

to any cause injury to people or damage to items. * ensure that the ECl module is connected to the diagnostic socket of the
The user is also responsible for complying complying with all the rules relating vehicle on which work is to be carried out

to vehicle security and activities in the workshop. * in case of emergency, disconnect the ECl module from the vehicle or
Carefully read the user manual before using the diagnostic tool and follow disconnect the USB cable

the instructions displayed on the screen. * ensure that while using the software, there is nobody near the vehicle you

are working on

 if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of the
workshop

* we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).



| connection diagrams area | information about a component | to highlight a component |

To access the consultation area of the connection diagrams of the vehicle under diagnosis proceed as follows:

select the GROUR the CATEGORY;
select the FORWARD NAVIGATION key (it is active, displayed in green)
to continue

select the CONNECTION DIAGRAMS AREA on the Keys Area

select the system or the component for
which you want to consult the connection
diagram; use the BROWSE keys to show all the
elements of the list

ELECTRICAL DIAGRAMS key
select the NAVIGATION key FORWARD to confirm

the key is enabled after selecting the the selection and continue

vehicle; it is always possible to consult the

same connection diagram of a diagnosis E.ASY. shows the required connection diagram.
path, if the the CONNECTION DIAGRAMS

AREA key is available
BROWSE keys NAVIGATION key FORWARD
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Connection diagrams area

The connection diagram of the system or of the selected component is displayed. The connection diagram area can be selected.
The following operations can be carried out:

scroll the diagram

expand or reduce the display of the connection diagram
highlight on the connection diagram a specified component
obtain information about a selected component

colour display the connection diagram (COLOUR key)

Scroll the diagram

select a point of the diagram

and, without releasing the pointer,
(mouse/touch screen pen) drag the
selection in the desired direction

key |1

displays the diagram in scale [00%:
select it when you want to return to
the initial display

ZOOM OUT key

reduces the enlargement of NAVIGATION key

the diagram display ZOOM IN key SEARCH key COLOUR key BACK/FORWARD
is active only after the increase the enlargement of allows to highlight a selected component
enlargement the diagram display on the connection diagram



| the consultation can be started | connection diagrams area |

| to highlight a component |

information about a component of the connection diagram

select the component on which you want information

Information type available for the connetion components

image picture of the component
location position of the vehicle

details info about the component
access way to access the component
connectors pin-out

general diagram

system diagram

group

components list belonging to a
same category

the available information are displayed
(the information type depends on the examined component)

select the information type you
want to consult

select the NAVIGATION key BACK to return to the display of
the connection diagram



| the consultation can be started | connection diagrams area | information about a component |

Highlight a component on the diagram

select the seArcH key

scroll the list of the components (which appear on the examined
diagram); use the BrROWSE keys to display all elements of the list

select the component you want to position on the diagram

confirm by selecting the Tick icon

The position of the selected component is indicated
on the connection diagram by a red arrow
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unit 10
diagnosis guide (GAD)

ATTENTION! GENERAL RULES FOR USE

This software may cause chassis movements and/ or engine start-up. The following instructions should always be strictly followed:

Be extremely careful. * check all instruments and ensure the vehicle is parked safely (e.g. handbrake
The user is responsible for the correct use of the EAASY. software so as not to any on, wheels chocked and with gearbox in neutral, etc...)

cause injury to people or damage to items.  ensure that the ECl module is connected to the diagnostic socket of the

The user is also responsible for complying complying with all the rules relating to vehicle on which work is to be carried out

vehicle security and activities in the workshop. . ‘ _
* in case of emergency, disconnect the ECI module from the vehicle or

Carefully read the user manual before using the diagnostic tool and follow the disconnect the LISB cable

instructions displayed on the screen.
* ensure that while using the software, there is nobody near the vehicle you
are working on

 if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of the
workshop

* we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).
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| GAD CHARACTERISTICS | STEP BY STEP DIAGNOSIS | REPAIR PROCEDURE | FAQ |

GAD CHARACTERISTICS

The Diagnosis Guide (GAD) guides the user through the diagnosis, programming and test operations of a vehicle.
It is the result of an analysis process, conducted through a sequence EVENTS & QUESTIONS.

The process may consist of one or more sequences (what must | do? what can | obtain?) as well as

the use of measuring instruments and/or the reading of documentation.

GAD FUNCTIONS
* supply diagnosis strategies
* to support the technicians in the workshop by detecting the fault(s) with a symptom
(not all faults are stored in the fault memory of the ECU!)

TO START
From EASY, by selecting the Group and the vehicle category, you can directly access the Diagnosis Guide.

Note

It is possible to suspend the activity of the GAD environment by
selecting another key from the control bar.

It is sufficient to select the piaGNOsIs GUIDE key again (highlighted
in the picture) to return to the corresponding environment. O
In this way all the running activities are retained.
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DIAGNOSIS GUIDE

STEP BY STEP DIAGNOSIS

From EASY select the vehicle Group>Category. The system automatically accesses the Diagnosis Guide (GAD), if available for the selected vehicle.

From any point of the diagnostic path you can also access the Diagnosis Guide by selecting the piagNosis GUIDE key (highlighted in the picture).
The GAD opening screen presents |2 macro-areas which can be selected.

these MACRO AREAS make it possible to access the
fault areas to solve the problem on the vehicle and are
the same for all vehicle categories

(the key is active if there are any available themes)

if the FORWARD key is green it is active, if gray then no
option can be selected from the list

GUIDE TO DIAGNOSIS |<ey

The DpIAGNOSIS GUIDE key in the corresponding environment remains selected.
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I. identify and select the desired macro area and confirm by selecting the FORWARD key, which is now active

the selection turns yellow

description of the selected macro area

the FORWARD key is activated after the selection

The next screen displayed is: the list of macro symptoms for the repair area.

the MACRO SYMPTOMS are the
classification of the possible anomalies

D if more symptoms pages are available, the browse key
is active to allow you to scroll long.

These cannot be contained in a single window, so it is
START key -~ recommended to read ALL the pages

BACK key



Q:DDD UNITS INDEX

DIAGNOSIS GUIDE

| GAD CHARACTERISTICS | STEP BY STEP DIAGNOSIS | REPAIR PROCEDURE | FAQ |

2. identify and select the macro symptom and confirm by selecting the FORWARD key which is now active

The list of symptoms is displayed.

list of symptoms

the selection turns yellow

the FORWARD key is activated after the
selection

Caution

if there is no further choices available,
from the selection of the macro symptom
the system directly accesses the fault area
screen (from point 2 to point 4)

3. identify and select the symptom and confirm it by selecting the FORWARD key which

is now active

the FORWARD key is activated
after the selection
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4. the fault area screen opens for the selected symptom (to continue with the diagnosis path go to point 5; the details of the environment are listed below)

The Diagnosis Guide guides the user through diagnosis until the detected problem is solved.
When viewing the fault screen, a step by step diagnosis path is performed. Some paths consist of one step only (and the fault is easily solved), others consist of ad-
ditional steps. Each step of the investigation (or NODE) is defined by an id code (investigation area), and characterised by a recommended repair related question.

focusing the investigation area

repair operation

question/answer to

access the next step

START key
(returns you to the opening window)

symptom identification code:
* name of the NODE

the BACK key
(allows you to return to previous item)

(or symptom)
* description
* identification code

‘ select an item of the list to continue

‘ (the FORWARD key is active)

ATTACHMENTS key
(displays attachement pop-ups)

MEASUREMENTS key
(displays measurement pop-ups)
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5. when viewing the fault area screen, and the ATTACHMENTS key is displayed, further documentation is available to assist in the analysis of the symptom;
select the key
The attachment pop-up opens

the pop-up presents a list of available
documentation in pdf format

-,

6. in the attachment pop-up, select the desired document and confirm by selecting the FORWARD key which is now active

-,

the document can be read with the Reader program

7. after reading the document, return to EASY and select the GreeN Tick icon (highlighted in the picture) closing the attachments pop-up
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8. if the MEASUREMENTS key is displayed it is necessary to carry out some measurements to assist in the analysis of the symptom,; select the key.
The measurement pop-up opens

the pop-up shows a list of possible
measurements together with an instructional
area containing some suggestions about the
selected measurement

in the displayed list the option has already been
selected and the green tick icon is active

->)

GREEN TICK icon

9. carry out the measurements according to the indicated sequence

10. from EASY select the green tick icon to close the measurement pop-up

1. return to the diagnosis; carry out the repairs and answer the questions, according to the information indicated
(ALWAYS read the documents or measurements associated to the recommended repair)

: end of the diagnosis process



Q:DDD UNITS INDEX

DIAGNOSIS GUIDE

| GAD CHARACTERISTICS | STEP BY STEP DIAGNOSIS | REPAIR PROCEDURE | FAQ |

FAQ

by selecting the START key

<

*if during the diagnosis guide, | redlise that the selected macro area does not define the correct diagnosis, may | change it?

you can return to the opening GAD screen, from where it is possible to choose a new macro area

* if during the diagnosis path | redlise that the macro symptom is not correct?

by selecting the BAcKk key « you return to the previous step (use it until you return to the macro symptoms list)

what is the function of the AsouT key?
the ABoUT key | man | OpenNs the information window (ECI connection, Activations, Framework version)

* what is the function of the USER MANUAL?
* the USER MANUAL Key | wamsn  allows you to access the user manual (pdf format)

* why are some descriptions coloured in blue?
* because they indicate keys already used

node name

* what does symptom identification mean? ;’4
D)

the identification of the symptom is defined by
the name of the symptom (or the node name)

identification code (ID)
description (it appears dfter the first selection)

sympton description
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CAUTION
The Eltracscope module is to be purchased separately from
Iveco Spares p.n. 99327084.

unit | |

Eltracscope

ATTENTION! GENERAL RULES FOR USE
This software may cause chassis movements and engine start-up. Be extremely The following instructions should be strictly followed always:
careful. * check that all instruments ensuring safe vehicle parking are present and

The user is responsible for the correct use of the EASY software in order to not activated (e.g: handbrake, wheel blocks, vehicle in neutral, etc...)

cause damage to people or things * be sure that the ECI module is connected to the diagnosis socket of the

The user is also responsible for complying with all security rules for vehicle activities vehicle on which work is to be carried out

in the workshop. , , :
* in case of emergency, disconnect the ECI module from the vehicle or

Carefully read the user manual before using the diagnostic tool and follow the disconnect the LISB cable

on-screen displayed instructions.
* ensure that while using the software with the vehicle, there are no people
near the vehicle you are working with

 if it is necessary that more than one person work near the vehicle, they are
all responsible for complying with security regulations of the workshop

* we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).
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the kit

The Kit comprises a set of portable equipment for checking the electric and electronic systems on the vehicles.

The main item of the Kit is the software that allows the PC to be used as digital oscilloscope.

Base -~ Cover
oscilloscope ADC-212 PC TAOQO test cable
600A CA/CC current clamp USB connection cable
60A CC current clamp parallel connection cable
attenuator 20:| parallel/USB adapter
multimeter probes and point probes 220V power supply unit
small crocodile clamps 2 Eltracscope connection cables/
measurement points
cigar lighter supply cable
CD with manual in electronic format

set-up guide

suitcase contents
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il kit-components

base

600A CA/CC current clamp —

attenuator 20:1 (2 pieces)

small crocodile clamps

Cover

TAQOO test cable
USB connection cable

parallel connection cable

parallel/USB adapter

220V power supply unit

2 Eltracscope connection cables/measurement points

cigar lighter supply cable
CD with manual in electronic format

set-up guide




@ UNITS INDEX

ELTRACSCOPE
| the kit | sw installation | connections | hw installation | interface |
sw installation
The first operation is to set-up the software. Insert the Oscilloscope Software CD in the special drive: software set-up begins.
I. choose the language used during set-up 3. select the software installation language and confirm (ok)
O 4. the software will be set up in the directory: c\oscilloscope;

select ok

2. confirm by pressing the INSTALL button

O the name of the hard

disk (C:) may be different
according to system
configuration
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5. scroll the menu using the side bar arrows and
select the USB-PP| port

6. confirm (oK)

=

7. follow the instruction given and press ok

-

8. the following path has been created
Programmes>lveco-Eltrac> & Eltracscope: select ok to continue

>

9. software set-up begins; wait for it to end

10. re-start the computer to make set-up effective

>
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connections

Once the software has been set up, connect the oscilloscope firstly to the power supply unit and then to the PC; then to the measuring instruments.

PARALLEL/USB ADAPTER (to connect the oscilloscope to the pc)

OSCILLOSCOPE
USB cable adapter/PC
parallel port
/
supply socket parallel cable/adapter
parallel/oscilloscope
LATER
external trigger
channel A channel B

. . example of connection with
coaxial connectors for the measuring ammeter clamp

instruments (probes, sensors, clamps, ...)
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hw installation

Then set up the hardware.
Connect the parallel-USB adapter to the oscilloscope and to the PC
(see fig. opposite): a new hardware is acknowledged.

I. guided set-up of the new hw begins: select NExT> to continue

-

2. continue by pressing the CONTINUE ANYWAY button

EltracScope

CH .~

3. the device has been correctly installed; press FiNISH

&

4. to start the Eltracscope click on Startslveco-Eltrac> & Eltracscope
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User-interface>menu bar>Automotive function

AUTOMOTIVE

MENU BAR

In the MeNU BAR, under item Automotive>Iveco,
models of wave shapes are available, classified
by range (Stralis, EuroCargo, Daily) and by
electronic system (EDC, Eurotronic, ...).

The models represent the type of signal to be
acquired and are fundamental in facilitating the
operator in acquisition.

v

The user:

* downloads the wave shape from the Iveco menu
(Automotive>Iveco>Stralis...)

* connects the Eltracscope to the vehicle

* selects the Go button (shown opposite) to read
the vehicle signal, WITHOUT having to set the
Eltracscope

cont.d >>

GO/sTOP (starts or stops the oscilloscope)
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User-interface>menu bar>File function>Save as
FILE>SAVE AS

MENU BAR

The user can save the acquisition using the
Save as command from the File Menu.

The Save as command allows the following
extensions:

* PSD (saves the wave shape and the Eltracscope
O settings)

* PSS (only saves the Eltracscope settings)

* txt

o wmf

* bmp

* Jpe

The PSD format, in particular, can be sent by

e-mail to the Centro Esperto Teleservizi (CET)
(Data Communication Services Expert Centre)
or to the Technical Help Desk (THD), who - in

CET and THD send the PSS file to the workshop via e-mail, as attachment. . .
turn - process it and return it to the sender

The user: as PSS file. The workshop downloads the PSS
* saves the attachment (select the path preferred) format and then performs correct acquisition
* start the Eltracscope __ (see indications opposite).
* from the Eftracscope select File>Open (be careful to define the File Type, which must be PSS)
« the Eltracscope automatically takes the correct values for signal acquisition In particular instances, intervention of the CET
« simply press GO to start acquisition may prove to be determinant.
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User-interface>tool bar>measurement functions

The TooLBAR contains functions with which the user can optimise viewing of the signal.

Below the main measurement functions are examined.

OSCILLOSCOPE button: opens a new Eltracscope window

MULTIMETER button: opens a new multimeter window

-

X|500 psidiv -

TIME BASE

TOOLBAR

Eltracscope display

The TiME BASE function is circled in the figure.

The time base checks the interval of time along the
Eltracscope display (time by division). On the screen
(axis x) there are 10 divisions, so the time interval
represented is |0 times the time base (as indicated by
the double red arrow, below and opposite).

—>» = X|500 psidiv ~




@ UNITS INDEX ELTRACSCOPE

| the kit | sw installation | connections | hw installation | interface |

User-interface>tool bar>measurement functions

x1 -

O MULTIPLIER

(Axis X)

The MuLTIPLER function is circled in the figure

The multiplier zooms on the time base.

If it is fixed at x| (as in the figure opposite), the acquisition is
shown completely on the display. If it is fixed at values other than
| (x5, for example, as in the figure below), only a part of the
acquisition is shown but with more detail.

-

a space bar appears to check the detail being viewed

to use the bar to get detailed information about other areas of
the acquisition
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User-interface>tool bar>measurement functions

S

—

channel A: 30V (x20)
the [icon indicates that
the signal is out of scale

present range:
0,30 (x20)

The channel A rRanGE function is circled in the figure.

The range allows you to specify the input value range; it indicates the
interval of the signal to be measured (amplitude along the vertical axis,
as shown by the double red arrow). Choose AuTO to automatically adjust
the input range to the signal amplitude. Choose ofr if you do not want to
view the acquisition on the channel.

if the signal is >20V, the input range needs to be adjusted to the signal: use
the attenuator (see figure below)

Settings>Probes. .. (select the channel and the option, in the example
below channel at option x20)

—A[30¥ x20) -

CHANNEL A: RANGE

note

channel A is coloured

in blue, as wave shape

detected on channel A

channel A: £20

__L attenuator: x20
+20 x 20 = +400

the values have been changed via
the attenuator
present range: -400, +400
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User-interface>tool bar>measurement functions

- oc -|foft -]

CURRENT // MULTIPLIER (AXIS Y)

The MuLTIPLIER CURRENT functions are circled in the figure

The current can take two values: D (direct current) and Ac (alternate current):
With vehicles always use direct current (D).

The multiplier zooms on the amplitudes along axis y. If it is fixed on oOFF, the
input interval is shown completely in the window (vertical dimension).

-

In the figure at the top the increase in every division on axis y is 3.
In the figure opposite, as the multiplier is set at x2, the increase is 1.5 (i.e. 3:2).

Use the slider bar to view hidden details.



@ UNITS INDEX

ELTRACSCOPE

| the kit | sw installation | connections | hw installation | interface |

User-interface>tool bar>measurement functions

tracing B: coloured in red, like the numerical values that
define it (see axis of the ys,on the righ tinthe example)

tracing A: coloured in blue, like the numerical values that
define it (see axis of the ys, on the left in the example)

The channel B functions are circled in
the figure

The range allows you to specify the
signal input value interval. Choose
AUTO to automatically adjust the input
range to the signal. Choose OFr if you
do not want to view the acquisition
on the channel.

For the other functions, see page |3.

D

BBV ~l|pc ~|fx1 ~
CHANNEL B: RANGE, MODE, MULTIPLIER
Preferably choose DC.

note
channel B is coloured in red, as wave
shape detected on channel B

C O

tracings invisible because both are fixed on OFF
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| the kit | sw installation | connections | hw installation | interface |

User-interface>tool bar>measurement functions

The trigger event is an instant taken as reference by the Eltracscope to make acquisition start.
The Eltracscope starts to collect the data immediately after the trigger instant or before/after a certain interval of time (function 7).

Note: triggering is preset if the wave shape models of the Automotive>lveco menu are used.

land?2 3:single (the trigger event is highlighted)

4:the trigger channel is channel B
5:rising edge

6:400mV

TRIGGERING

[60] [Stopped Trigger R0 ~| [ch A ~| [Rising ~| [19.0 [2v x20)[26 |29
6

1 2 3 4 5 7

go/stop: starts or stops the Eltracscope
stopped/running in progress

trigger modes

trigger channels

trigger direction (falling edge/rising edge)

trigger threshold (trigger movement)

N o N W RN R

< > delay after trigger/pre-trigger

L, OO0 0O

7:-20% (see double black arrow)
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ELTRACSCOPE

| the kit | sw installation | connections | hw installation | interface |

User-interface>tool bar>measurement functions

>

SIGNAL ACQUISITION
if the default value is left, acquisition is slow

|

accelerated acquisition is possible:

* select Settings>Options>Advanced

the Advanced Options window opens

* change the numerical value at the top to 3000/Standard sampling
» confirm by pressing the ok button

it is possible to customise the acquisition entering notes at the

bottom of the display (above the triggering menu bar):

* select Settings>Notes
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unit |2

Bluetooth Device
user and installation manual

ATTENTION! GENERAL RULES FOR USE

This software may cause chassis movements and/ or engine start-up. The following instructions should always be strictly followed:

Be extremely careful. * check all instruments and ensure the vehicle is parked safely (e.g. handbrake
The user is responsible for the correct use of the EAASY. software so as not to any on, wheels chocked and with gearbox in neutral, etc...)

cause injury to people or damage to items.  ensure that the ECl module is connected to the diagnostic socket of the

The user is also responsible for complying complying with all the rules relating to vehicle on which work is to be carried out

vehicle security and activities in the workshop. . ‘ _
* in case of emergency, disconnect the ECI module from the vehicle or

Carefully read the user manual before using the diagnostic tool and follow the disconnect the LISB cable

instructions displayed on the screen.
* ensure that while using the software, there is nobody near the vehicle you
are working on

 if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of the
workshop

* we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).
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h... UNITS INDEX

| hardware characteristics | security and use conditions | system configuration | Hw installation | eci-bluetooth session step by step | fag | troubleshooting |

hardware characteristics
Thanks to the BTM you will be able to connect the E.A.SY diagnosis system to any EClI module connected to any vehicle in the IVECO range, equipped

with 30-pole diagnosis socket without cables (wireless mode). The following technical information will be very useful.

blue led: it lights only at the beginning
of the ECl/vehicle connection

green switching on led: it indicates
the power supply

o

Bluetooth symbol

serial port of the BTM

fixing point
Bluetooth adapter
identification code
(12 digits)
70 grams TEMPERATURE OPERATING RANGE from 0°C to +70°C

WEIGHT

DEGREE OF PROTECTION  IP40 from -30°C to +85°C

STORAGE OPERATING RANGE
from 0 to 90%

RESISTANCE TO THE FALLS 1 metre on concrete HUMIDITY WITHOUT CONDENSATE
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security and use conditions
Some simple security arrangements to ensure the correct and safe use of the ECI - Bluetooth module:
¢ do not power the EClI module during the assembly / disassembling phases of the BTM
¢ place the connection cable between the ECU and the ECI module in a stable and safe position and avoid trapping it

¢ avoid placing obstacles and metallic objects within the range of the two bluetooth modules because they can adversely affect
the communication

¢ do not insert foreign bodies into the connectors because the device could be damaged

¢ do not use the device at temperature and humidity rates higher than those ones indicated in the TECHNICAL DETAILS

Check that:
¢ the ECl module is connected to the diagnosis socket of the vehicle on which work is to be carried out
¢ check all instruments and ensure the vehicle is parked safely (e.g.: handbrake on, wheels chocked and with gearbox in neutral, etc...)

¢ that while using the software, there is nobody working on or near the vehicle you are working with

Furthermore always strictly follow the instructions displayed on the screen.

At the end of the activities always disconnect the ECI-Bluetooth module from the vehicle.
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system configuration

Thanks to the new BTM you will be able to connect the EASY. diagnosis system without cables (wireless mode) to any vehicle in the IVECO range,
which is equipped with the 30-pole diagnostic socket.
To connect an IVECO vehicle to the EASY. diagnosis system proceed as follows:

o update the EASY. sw to the version 3_|I

° the firmware of the ECl module must also be updated

\—> I. from EASY. select the TOOLS>ECI MANAGEMENT key
. select TEST AND PROPERTIES to check the update status of the ECI module
. select the use key and then the PROPERTIES key

. select the TIcK icon

Ul A W DN

. select the red cross key to end the enable the procedure of the ECI module and to operate
with the Bluetooth

If the ECI module is to be updated, EA.SY. automatically runs the EFU application.
a. read the warning message

O b. select the green Tick icon to continue with the update
c. select the sTART key and follow the instructions displayed on-screen

Wait for the end of the procedure.

d. at the end select the exiT key to continue
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Before starting the search carefully check that:

¢ the EASY. Blutooth device is enabled

On the Windows tools bar check that the Bluetooth connection icons are displayed as indicated below:

t Conditions of the BT sYMBOL icon
BT CONNECTION ICON
BISTHBEOL ICON white | BT function installed, connection enabled

If the BT connection is not enabled: . red BT function installed, connection disabled

\J

i. select the
BT CONNECTION icon

green | BT function installed, connection in
progress

& Conditions of the BT CONNECTION icon

BT connection enabled

ii. select“Enable Bluetooth”

E BT connection disabled

If on the Windows tools bar the Bluetooth symbol icon is not displayed: H

i

Select the Windows XP start button, then Programs>Startup>BT Tray
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Hw installation
To connect the BTM to the ECl module carefully remove the protection caps placed on the fixing screws.

protection cap Caution
Do not connect the ECl module to a

PC during the assembly / disassembling
phases of the BTM.

protection cap

I. unscrew the two outer screws of the EClI module connectors using a torx screwdriver tip
attention: some ECl models are equipped with cross head screws, therefore please use the appropriate

tool to remove them

2. position the BTM on the ECI module aligning the serial ports of the two instruments

3. insert the new Torx screws supplied with the BTM (longer than the normal ones) in
the fixing holes (see page 2) and tight them

4. finally refit the protection caps to avoid contact with dirt or water of the ECl modules
metallic parts
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eci-bluetooth session step by step
ECI MANAGEMENT > TEST AND PROPERTIES

for normal session

FIRST INSTALLATION
O & point 20

START CONDITIONS
ECI POWER SUPPLIED BY THE VEHICLE AND CONNECTED TO E.ASY. VIA USB

V'S

I. from EAASY. select the TOOLS>ECI MANAGEMENT key

2. the window ECI Management is displayed; select TEST AND PROPERTIES

>

V'S

3. select the use key (if it has not been selected) O
and then the TesT key
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4. the Test checks the E.AASY. connection with the ECI module
(during the check the ECI emits a continuous beep);
select the green Tick icon to complete the test

-
Oi PROPERTIES key

5. select the PROPERTIES key: you access the ECI Properties environment where the ECI module properties are analyzed

When you contact the service assistance this information must be provided.

According to the connection type (USB or Bluetooth) the ECI Properties window
displays different information (see detail).

ECI Properties details
&= next page

6. select the green Tick icon (ECI Properties environment) and
then the cross icon (Test and Properties environment)
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USB CONNECTION BLUETOOTH CONNECTION

1 T
2 > 2 4>
3 3 —
4 4 —
5 5
6 6
7 —— 7
8
s
1 | EClI module serial number:the number is also SN — <— 1 | ECl module serial number
indicated on the rear part of the instrument 2 | Bluetooth connection
2 | USB connection 3 | ECl module name
3 | firmware version of the Bluetooth ECI 4 | Bluetooth adapter identification code
4 | firmware version of the ECI USB 5 | firmware version of the Bluetooth ECI
5 | Loader 6 | firmware version of the ECI USB
6 |Bios 7 | Loader
7 | enable status 8 | Bios
9

if the ECl is not enabled for the BTM, update the ECI
firmware (see page 4)

enable status
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ECI MANAGEMENT > BLUETOOTH ECI SEARCH

7. disconnect the ECl module from the vehicle

8. remove the USB connection cable between the ECl module and the E.ASY. diagnostic system
9. fit the BTM

10. connect the ECI module to the vehicle by using the appropriate cable O
I 1. verify that both the leds on the BTM switch on and then the blue one switches off
2. from the EAASY. program select the TooLs key and then ECI MANAGEMENT —

I 2. select BLUETOOTH ECI SEARCH

: if the automatic search is not correctly carried out
I 4. select the AUTOMATIC SEARCH key o
SN & |5a

I5. at the end of the search procedure EASY. lists the ECI-
Bluetooth modules found; select the ECI-BTM you want
to communicate with and then press the eNABLE key

-

unique id code of the BT
adapter for ECI (see page 2)
ECI-BTM ia-
Before starting check that: aslsooa
the Bluetooth ECl is switched on and connected Q ECI module serial .
to the vehicle AUTOMATIC SEARCH key number (see page 9)

the Bluetooth ECl starts beeping
the EASY. Bluetooth is enabled (see page 5)

ENABLE key
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16. select the Tick icon (Bluetooth Connection window) to confirm the connection and continue the association procedure
O enter the name for the ECI-BT (maximum 8 digits)
select the Tick icon to complete the association procedure

© (and close the window Bluetooth ECI NAME)

select the cross icon to complete the search process
(and close the Bluetooth ECI SEARCH window) m

: MANUAL ENABLE (15a)

i i. if the automatic search procedure is not carried out correctly (more than 2 times), it will be necessary to run the manual search procedure
i, select the MANUAL ENABLE option

iii. select the eNABLE key to start the manual search procedure

iv. read the identification code on the label supplied with the package and
enter the identification code (12 digits) of the BT adapter

v. confirm by selecting the green Tick icon

© vi. follow the instructions shown

ENABLE key

MANUAL ENABLE key
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after selecting the vehicle range and type of the vehicle you
want to work with, select the FORWARD key

if you are using the Bluetooth the system requires you to
confirm before connecting to the ECI (no confirmation is
required for the usb connection); select the green Tick icon

check that the ECI and Bluetooth are near the vehicle you want to
work with; confirm by selecting the green Tick icon

The diagnosis can be started.

symbol of the connection
mode between the Panasonic
PC und the ECI module

If the connection is via Bluetooth,
the name of the used ECI-BT
is also displayed near the BT

symbol: check that it is the right
module.

during the Bluetooth connection the blue BTM led (see page 2) remains on
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faq

I. | want to change the ECI-BT recognition name
Solution

It is necessary to carry out the automatic search procedure again.

2. You do not want to continue with the ECI-BT association
Solution

Select the cross icon to delete the running procedure.

O

3. | would like to replace the ECI or the BTM module
Solution

It is necessary to carry out the automatic search procedure again
(see p. 10).

4. The system does not display the windows to select the ECI
module
Solution

It is not an error; it means that the Panasonic PC is connected to an ECI

module only via USB cable; no ECI-BT is connected to the PC.

5 | would like to use a different ECl module

Solution
a. select the oN/oFF LINE key on the EAASY. tools bar to operate in
OFF-LINE mode

b. select the veHICLE key on the E.A.SY. tool bar

c. select the BLUETOOTH key to display the ECI-BT modules available or
the use key to display the USB mode modules

d. select the desired module
e. select the Tick icon to confirm the option

EASY. is now ready to operate in the ON-LINE mode and to continue
with the diagnosis session.
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troubleshooting

. If the operating mode is changed (from OFF-LINE to ON-LINE)
the Bluetooth device displays a communication fault.
Solution

Check the Bluetooth configuration.
a. exit the EAASY. program
b. open Windows Explorer

c. look for My Bluetooth Places, select it with the right button
and click on opeN

MY BLUETOOTH PLACES

OPEN

d. the menu Bluetooth Tasks opens; select the last option of the menu:

View or Modify Configuration (see picture)

e. from the Bluetooth Configuration window select Discovery

BLUETOOTH

TASKS O

BLUETOOTH
CONFIGURATION

DISCOVERY

f. disable the option Look for other Bluetooth devices
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2. During Active Diagnosis/Engine Test some communication faults
occur.
Solution |

Check the following conditions:

a. did you select the OFF-LINE key to change to the ON-LINE mode?  b. from the applications bar select with the right button

b. is the Bluetooth blue key switched off? the ANTIVRUS icon

from E.ASY. select the OFF-LINE mode and then ON-LINE

c. are the Bluetooth ECI blue and green LEDs switched off?

check that the battery isolator is ON ANTIVIRUS icon

O

Solution 2

Before carrying out the Engine Test or the Active Diagnosis disable the
antivirus.

a. minimize the EASY. program, by selecting the MINIMISE icon c. select ExiT

O MINIMISE icon

Do NOT carry out this operation
during the connection to:

* Internet

* EASY sw update

* RSS
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d. the Trend Micro PC-illin Internet Security |4 window opens; h. the antivirus is active: close the window of the application to return
select Yes to the Windows desktop

D

e. check that the antivirus icon is not displayed on the applications bar
and continue working with EASY.

f. atthe end of the operations, enable the antivirus as indicated below:

Programs>Trend Micro PC-cillin Internet Security 14>Main console

Solution 3

If you are using the bluetooth printer;, be sure that no documents are
waiting to be printed:

MINIMISE icon

a. minimize the EASY. program, bf selecting the MINIMISE icon

g. the Trend Micro Application opens
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b. on the applications bar check that the PRINTER icon is displayed

c. ifthe icon is present, open the printer window

d. select the option Cancel all documents

e. confirm (select Yes and if these are your documents)

O

f. close the Printer window
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eci-bluetooth session step by step
ECI MANAGEMENT > TEST AND PROPERTIES

FIRST INSTALLATION

D

START CONDITIONS
ECI POWER SUPPLIED BY THE VEHICLE AND CONNECTED TO E.ASY. VIA USB

V'S

I. from EAASY. select the TOOLS>ECI MANAGEMENT key

2. the window ECI Management is displayed; select TEST AND PROPERTIES

>

V'S

3. select the use key (if it has not been selected) O
and then the TesT key
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4. the Test checks the E.AASY. connection with the ECI module
(during the check the ECI emits a continuos beep);
select the green Tick icon to complete the test

-
Oi PROPERTIES key

5. select the PROPERTIES key: you access the ECI Properties environment where the the ECI module properties are analyzed

When you contact the service assistance this information must be provided.

According to the connection type (USB or Bluetooth) the ECI Properties window
displays different information (see detail).

6. select the green Tick icon (ECI Properties environment) and
then the cross icon (Test and Properties environment)



USB CONNECTION

N OO OB WDN

ECI module serial number: the numer is also
indicated on the rear part of the instrument

USB connection

firmware version of the Bluetooth ECI

firmware version of the EC| USB

Loader

Bios

N oo~ w|N

enable status
if the ECl is not enabled for the BtM, update the ECI
firmware (see page 4)

© oO~N O O h W DN P

BLUETOOTH CONNECTION

ECI module serial number

Bluetooth connection

ECI module name

Bluetooth adapter identification code

firmware version of the Bluetooth ECI

firmware version of the EC| USB

Loader

Bios

O N0 r~ WIN|PF

enable status
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ECI MANAGEMENT > BLUETOOTH ECI SEARCH

7. disconnect the ECI module from the vehicle

8. remove the USB connection cable between the ECl module and the E.ASY. diagnostic system

9. fit the BtM

10. connect the ECI module to the vehicle by using the appropriate cable O
I 1. verify that both the leds on the BtM switches on and suddenly the blue one switch off

2. from the EAASY. program select the TooLs key and then ECI MANAGEMENT —

I 2. select BLUETOOTH ECI SEARCH

I 4. select the AUTOMATIC SEARCH key

I & |5a

if the automatic search is not correctly carried out

5. at the end of the search procedure EASY. lists the
ECI-Bluetooth modules found; select the ECI-BtM
you want to associate and then press the ENABLE key

-

unique id code of the BT
~ adapter for ECI (see page 2)
ECI-BtM iati
Before starting check that: asspaa 1on
the Bluetooth ECI is switched on and connected Q ECI module serial .
to the vehicle AUTOMATIC SEARCH key number (see page 9)

the Bluetooth ECIl emits some beeps
the EASY. Bluetooth is enabled (see page 5)

ENABLE key
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16. select the Tick icon (Bluetooth Connection window) to confirm the connection and continue the association procedure

O enter the name for the ECI-BT (maximum 8 digits)

select the Tick icon to complete the association procedure
© (and close the window Bluetooth ECI NAME)

select the cross icon to complete the search process
(and close the Bluetooth ECI SEARCH window) m

| MANUAL ENABLE (15a)

i i. if the automatic search is not correctly carried out for more than twice, it is necessary to run the manual search procedure

i ii. select the option MANUAL ENABLE

iii. select the eNABLE key to start the manual search procedure

iv. read the identification code on the label supplied with the package and
enter the identification code (12 digits) of the BT adapter

v. confirm by selecting the green Tick icon

© vi. follow the indicated instructions

>

ENABLE key
MANUAL ENABLE key




after selecting the family and type of the vehicle you want to
work with, select the FORWARD key

if you are using the Bluetooth the system requires to confirm
before connecting to the ECI (no confirmation is required for
the usb connection); select the green Tick icon

check that the ECI and Bluetooth are near the vehicle you want to

work with; confirm by selecting the green Tick icon

The diagnosis can be started.

symbol of the connection
mode between the Panasonic
PC und the ECI module

If the connection is via Bluetooth,
the name of the used ECI-BT
is also displayed near the BT

symbol: check that it is the right
module.

during the Bluetooth connection the blue BTM led (see page 2) remains on
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E.A.SY. software automatic updating

ATTENTION! GENERAL RULES FOR USE

This software may cause chassis movements and/or engine start-up. The following instructions should always be strictly followed:

Be extremely careful. , .
Y - check all instruments and ensure the vehicle is parked safely

The user is responsible for the correct use of the EASY. software so as not (e.g: handbrake on, wheel chocked and with gearbox in neutral, etc. ..)
to any cause injury to people or damage to items. - ensure that the ECI module is connected to the diagnostic socket of the

The user is also responsible for complying with all the rules relating to vehicle on which work is to be carried out

vehicle security and activities in the workshop. - in case of emergency, disconnect the ECI module from the vehicle or

. . , disconnect the USB cable
Carefully read the user manual before using the diagnostic tool and follow - ensure that while using the software, there is nobody near the vehicle you

the instructions displayed on the screen. are working on

- if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of
the workshop

- we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).
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| EASY/ EASY. LIGHT | MODUS /1T 2000 |

REQUIREMENTS

Automatic updating of the E.ASY. applications requires an Internet connection to the Eftrac server.

Connection to the Internet can be done in one of the following ways:

I via modem to the local provider
2 via local network or via ADSL
3 via modem to the Eltrac pop in ltaly

The above three connection types are described below.

UNIT THIRTEEN

The Release installation is different according to the diagnosis instrument used
(EASY. and EASY: LIGHT or Modus/IT 2000):

follow the instructions about the instrument you are using.

Note

The EASY. system is set for connection to the Eltrac pop via modem (Option 3).The
configuration of Options | and 2 are to be taken care of by the workshop (under the
guidance of specialized IT personnel).
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E.A.SY. SW UPDATE UTILITY INSTALLATION

After inserting the second CD Software Release the system automatically opens
the following window:

D

I Select EASY. INSTALLATION FOR SOFTWARE UPDATE UTILITY . This allows you
to install the functionality for the updating of the diagnosis system through
the Web.

Note
Select the EXIT button to exit the application (without carrying out the installation).

Note

Both CD's are equipped with Autorun mode. If this function is not available, select the
SETTINGS Icon and from the list and select the RUN option.

Then enter the following path E\setup.exe and confirm by selecting the GREEN TICK
icon.

UNIT THIRTEEN

2 Select the installation language and press the OK key.

S

3 Select the country. Proceed by selecting the NEXT> key.

-

4 Type in the number to dial to before dialling (for switchboard) leave the
field blank if no number is required. Press the NEXT> key.
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| EASY/ EASY. LIGHT | MODUS /1T 2000 |

First use > Connection
To carry out automatic updating of the EASY software: follow the operations described below
I Start EASY.
2 Select the TooLs > EASY. Software Update key.
3 The Update Software screen is shown.

4 Select the UPGRADE LIST key

-— -

Software Update
Screen

5 At this point only it is necessary to choose the type of
option with which you intend to connect your computer to

Note the Internet.

To edit the calling location and the external

line access code you can also select the

TOOLS > Telephone line setting key

6 Connect the system to the Internet selecting one of the
options indicated.

UNIT THIRTEEN 3
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| EASY/ EASY. LIGHT | MODUS /1T 2000 |

|. YOUR PROVIDER

The following picture is displayed

n Connections List

MY POP 1
MY POP 2

Select your personal connection and then the TICK key.

After having pressed the TICK key, communication with the Eltrac server has
been established.

2.LOCAL NETWORK (LAN)

Communication with the Eltrac server is automatically activated, providing the
instrument has been correctly configured for the Internet connection.

3. ELTRAC PROVIDER IN ITALY

in Italy: by using a telephone provider enabling the call no. 702, the local call
rate will be applied, from anywhere in ltaly

otherwise (by calling the telephone no. Ol 1), a call rate for a trunk call
will be applied (local call rate if you are calling from anywhere in Turin)

in other countries:

the international call rate will be applied

The communication to the server is established.

UNIT THIRTEEN

When the connection to the Eltrac server has been established, the available
updates are shown on the screen.

Warning

If the connection (whatever connection type has been activated) is activated for
the first time, the Eltrac server sends and installs the security certificate for the
station; confirm by selecting the YES key.

Security certificate.
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| EASY/ EASY. LIGHT | MODUS /1T 2000 |

Software Update Screen

The Operative area of the Software Updating Screen contains the following
active elements

- UPGRADE LIST key

sends the ELTRAC server the request to update the list of the
applications available; it is always active.

- DOWNLOAD key

transfers the applications requested from the ELTRAC server to
the user; it becomes active in response to the selection of an
available application.

UNIT THIRTEEN

- INSTALL key

installs the available applications already transferred from the
ELTRAC server to the user; it becomes active in response to the
selection of an application transferred without errors.

List Area with navigation keys between page
This list is selectable and contains the list of the applications needed
to upgrade the EASY. software.
A led indicates the application availability status according to the
rules below:
red:  the application is available for transfer
green: the application has been transferred and transfer has
been completed with no errors; the application is ready
for installation

blue: the application has been installed on the computer

Selecting the question mark on the INFO column obtains
information about the application.

TheTitle area contains the CROSS key: when selected, this closes the EA.SY.
Software Updating environment.

Pay Attention to the notes

The notes inform you that in order to use an application other programs also
need to be transferred and installed on which the application chosen depends.

In the figure, note | associated with the ABS Programming application, informs you that to
install the ABS Programming application, the TrakkerUpdate program needs to have been
transferred and installed.
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First use > Transferring the updates

The request for the available updates has been sent to the ELTRAC server (selecting the UPGRADE LIST key) which acknowledges the unit in use through the
activation code, stores the configuration, processes the request and transmits the list of the possible updates.

I The list of the available updates (red led) is displayed in the lists area

2 Select the QUESTION MARK related to the application you wish to download: the corresponding information,
any dependence on other programs and the size of the application are displayed

3 Select the required updates among those available (red led)

4 The DOWLOAD key has become active; select the DOWLOAD key

The request for download is sent to the ELTRAC
server, which processes the request and transfers the
files. The ELTRAC server updates the memory with
the transfers performed by the unit in use.

o 5 Itis possible to download one or more updates
simultaneously.

6 At the end of transfer; if the result has been successful, the
led that indicates the file status becomes green (application
received)

Dependent applications

Certain applications cannot be installed without firstly transferring and installing other programs.These are known as dependent or subordinate applications.VWhen
a subordinate application is selected (also mentioned in the notes) a message alerts the user that it is necessary to also download the programs on which the
application depends. If the user confirms the transfer; the subordinating programs are transferred automatically.

UNIT THIRTEEN 6
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First use > Installation of the updates

I Select an update transferred and received without errors
(green led - received)

2 Select the INSTALL key to carry out installation of the software

If the application selected is subordinated to another program not
present on the computer vet, the system asks to install the
subordinating program before proceeding with the installation of the
application chosen.

It is always possible to download a package that has already been downloaded
again.A message warns the user

UNIT THIRTEEN

Upgrades list

Easy Software Update

B Available: 9
O Received: 1
M |nstalled: O




<]:"]|]|| UNIT INDEX SW AUTOMATIC UPDATING

D

| EASY./ EASY. LIGHT | MODUS /1T 2000 |

E.A.SY. SW UPDATE UTILITY INSTALLATION

The Modus Station or the IT 2000 tester must possess a subscription to the teleservices updated to version 2.1 or subsequent one (Release 2.1 RSS Manual).

After inserting the second CD Software Release the system automatically opens I Select the installation language and press the ok key.
the following window:

( > ( ) 2 Select the country. Proceed by selecting the NEXT> key.

MODUS IT 2000

3 Select EASY. INSTALLATION FOR SOFTWARE UPDATE UTILITY . This allows you o

to install the functionality for the updating of the diagnosis system through

the Web. 3 Type in the number to dial to before dialling (for switchboard) leave the

field blank if no number is required. Press the NEXT> key.

Note
Select the EXIT button to exit the application (without carrying out the installation).

Note

Both CD’s are equipped with Autorun mode. If this function is not available, select the
SETTINGS Icon and from the list and select the RUN option.

Then enter the following path E\setup.exe and confirm by selecting the GREEN TICK o

icon.

UNIT THIRTEEN 8
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First use > Connection
To carry out automatic updating of the EASY software: follow the operations described below

I Start EASY.
2 Select the TooLs > EASY. Software Update key.
3 The Update Software screen is shown.
4 Select the UPGRADE LIST key
Software Update
Screen
5 At this point only it is necessary to choose the type of
option with which you intend to connect your computer to
the Internet.
Note
To edit the calling location and the external
line access code you can also select the ,
TOOLs > Telephone line setting key 6 Cohnec’F the system to the Internet selecting one of the
options indicated.

UNIT THIRTEEN
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|. YOUR PROVIDER

The following picture is displayed

n Connections List

MY POP 1
MY POP 2

Select your personal connection and then the TICK key.

After having pressed the TICK key, communication with the Eltrac server has
been established.

2.LOCAL NETWORK (LAN)

Communication with the Eltrac server is automatically activated, providing the
instrument has been correctly configured for the Internet connection.

3. ELTRAC PROVIDER IN ITALY:

in Italy: by using a telephone provider enabling the call no. 702, the local call
rate will be applied, from anywhere in ltaly

otherwise (by calling the telephone no. 011), a call rate for a trunk call
will be applied (local call rate if you are calling from anywhere in Turin)

in other countries:

the international call rate will be applied

The communication to the server is established.

UNIT THIRTEEN

When the connection to the Eltrac server has been established, the available
updates are shown on the screen.

Warning
If the connection (whatever connection type has been activated) is activated for the

first time, the Eltrac server sends and installs the security certificate for the station;
confirm by selecting the YES key.

Security certificate.
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Software Update Screen

The Operative area of the Software Updating Screen contains the following
active elements

- UPGRADE LIST key

sends the ELTRAC server the request to update the list of the
applications available; it is always active.

- DOWNLOAD key

transfers the applications requested from the ELTRAC server to the
user; it becomes active in response to the selection of an available
application.

UNIT THIRTEEN

- INSTALL key
installs the available applications already transferred from the
ELTRAC server to the user; it becomes active in response to the
selection of an application transferred without errors.

- List Area with navigation keys between page
This list is selectable and contains the list of the applications needed
to upgrade the EASY. software.
A led indicates the application availability status according to the
rules below:
red:  the application is available for transfer
green: the application has been transferred and transfer has
been completed with no errors; the application is ready
for installation

blue: the application has been installed on the computer
Selecting the question mark on the INFO column obtains information
about the application.

The Title area contains the CROSS key: when selected, this closes the EA.SY.
Software Updating environment.

Pay Attention to the notes

The notes inform you that in order to use an application other programs also need
to be transferred and installed on which the application chosen depends.

In the figure, note | associated with the ABS Programming application, informs you that to
install the ABS Programming application, the TrakkerUpdate program needs to have been
transferred and installed.
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First use > Transferring the updates

The request for the available updates has been sent to the ELTRAC server (selecting the UPGRADE LIST key) which acknowledges the unit in use through the
activation code, stores the configuration, processes the request and transmits the list of the possible updates.

I The list of the available updates (red led) is displayed in the lists area

2 Select the QUESTION MARK related to the application you wish to download: the corresponding information,
any dependence on other programs and the size of the application are displayed

3 Select the required updates among those available (red led)
4 The DOWLOAD key has become active; select the DOWLOAD
key

The request for download is sent to the ELTRAC
server, which processes the request and transfers the
files. The ELTRAC server updates the memory with

o the transfers performed by the unit in use.
5 Itis possible to download one or more updates
simultaneously.

6 At the end of transfer; if the result has been successful, the
led that indicates the file status becomes green (application
received)

Dependent applications

Certain applications cannot be installed without firstly transferring and installing other programs.These are known as dependent or subordinate applications.When
a subordinate application is selected (also mentioned in the notes) a message alerts the user that it is necessary to also download the programs on which the
application depends. If the user confirms the transfer; the subordinating programs are transferred automatically.

UNIT THIRTEEN [2
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First use > Installation of the updates

I Select an update transferred and received without errors
(green led - received)

2 Select the INSTALL key to carry out installation of the software

If the application selected is subordinated to another program not
present on the computer vet, the system asks to install the
subordinating program before proceeding with the installation of the
application chosen.

It is always possible to download a package that has already been downloaded
again.A message warns the user

UNIT THIRTEEN

Upgrades list

Easy Software Update

B Available: 9
O Received: 1
M |nstalled: O
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certifications
ATTENTION! GENERAL RULES FOR USE
This software may cause chassis movements and/ or engine start-up. The following instructions should always be strictly followed:
Be extremely careful. * check all instruments and ensure the vehicle is parked safely (e.g. handbrake
The user is responsible for the correct use of the EAASY. software so as not to any on, wheels chocked and with gearbox in neutral, etc...)

cause injury to people or damage to items.  ensure that the ECl module is connected to the diagnostic socket of the

The user is also responsible for complying complying with all the rules relating to vehicle on which work is to be carried out

vehicle security and activities in the workshop. . ‘ _
* in case of emergency, disconnect the ECI module from the vehicle or

Carefully read the user manual before using the diagnostic tool and follow the disconnect the LISB cable

instructions displayed on the screen.
* ensure that while using the software, there is nobody near the vehicle you
are working on

 if it is necessary for more than one person to be working on or near the
vehicle, they are all responsible for complying with security regulations of the
workshop

* we strongly suggest that the ECI modules be visibly and uniquely identified
(for example by using coloured adhesive tape, labels with names, etc...).



| C-Tick conformity | RAEE conformity |
ECI MODULE
DECLARATION OF CONFORMITY c €

ELTRAC s.rl.

Strada di Settimo 388/2
[0156 Turin

[TALY

Declares that this product complies with the provisions of the following community directives:

89/336/EEC

Conformity with these directives means that the following harmonised standards have been applied:

EN 55022: 1998 Equipment for information technology - Radio disturbance characteristics - Limits and methods of measurement

EN 61000-6-2: 2001 Electromagnetic Compatibility Directive (EMC) - Section 6-2: General rules - Immunity for industrial environments
(IEC 61000-6-2: 1999 (Amended))
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BLUETOOTH MODULE

DECLARATION OF CONFORMITY c €

Declares that this product complies with the provisions of the following community directives:

89/336/EEC

1999/5/CE R&TTE Directive

Conformity with these directives means that the following harmonised standards have been applied:

EN 60950-1:2001

EN 50371-:2002

EN 301 489-17V1.2.1

EN 300 328-2VI.2.1

Equipment for information technology - Safety - Section I: general requirements

Human exposure to electromagnetic fields (10 MHz - 300GHz) - General Standard for proving the conformity of low
power electronic and electric equipment with the base limits established for the population.

Electromagnetic compatibility and questions concerning the radio frequency spectrum (ERM); Electromagnetic
compatibility standard (ERC) for radio equipment and services - Section |7: Specific conditions for broadband
transmission systems in the 2.4GHz band and high performance RLAN equipment in the 5GHz band.

Electromagnetic compatibility and questions concerning the radio frequency spectrum (ERM); broadband transmission
systems; equipment operating in the 2.4GHz ISM band and which use broad spectrum modulation techniques - Section 2:
Harmonised European standard on the essential requirements of section 3.2 of the R&T TE directive.
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DECLARATION OF CONFORMITY o

Declares conformity with the essential requirements for C-Tick markings certified by compliance with the following standards and rules:

AS/NZS 4771:2000 including amendment no. | Technical characteristics and test conditions for data transmission equipment operating in the
900MHz, 2.4GHz and 5.8 GHz band using broad spectrum modulation techniques.

Radiocommunications (Spread spectrum devices)  Class Licence 2002 of | | December 2002. (The Australian Communications Authority issues
this Class Licence under sub-section 132(1) and section 135 of the 1992
Radiocommunications Act).
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INFORMATION FOR USERS ABOUT THE DISPOSAL OF OBSOLETE ELECTRIC AND ELECTRONIC EQUIPMENT

This symbol on the products and/or shipping documents means that the used electric and electronic products must not be mixed with generic
waste.

For correct treatment, recovery and recycling, take these products to the designated collection points.

Correct disposal of this product will help to save precious resources and avoid potential adverse effects on human health and on
the environment, which could otherwise result from inappropriate disposal.

In the event of incorrect disposal of this material, sanctions may be applied according to national laws.

Information for disposal outside the European Union

This symbol is valid within the European Union only. If you want to dispose of this product, contact the local authorities or dealer and ask for
information on how to do so correctly.
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